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Equipment Recycling
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About This Guide

Using This Guide

This user guide provides instructions for installing, operating and
maintaining Objet 3D printing systems. It explains how to use features, and
provides practical examples to guide you as you use the system.

This document is meant to be used with Objet30 3D printers, running
software version 30.2.1, and with Objet Studio software version 9.2.

This guide assumes that:

® all the hardware, software, and network components of your Objet
system are installed, configured, and operating correctly.

® the operator has a working knowledge of the Windows® PC platform.

For More Information

1-2

Visit http://www.stratasys.com/ for more details about Objet printer
technology, products and consumables, and for service and support
contacts.

For other documents that relate to Objet30 3-D printing systems, and for
this document in other languages, contact your regional Stratasys
Customer Support office.

If you have any questions about the information presented in this
document, or if you have any comments or suggestions for future editions,
please send a message to c-support@stratasys.com.
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Terms Used in This Guide

build tray

cleaning fluid

client/user workstation

Objet™ printer

Printer computer

Printer interface

Printer software

host/server workstation

Job Manager™

Model material

Objet Studio™

OBJTF (Objet Tray Format)

OBJZF (Objet Z Format)

resin

DOC-24333 Rev. A

In Objet Studio: The surface displayed on the screen that
represents the actual build tray in the printer.

In the printer: The surface upon which models are produced.

Cleanser for flushing model feed tubes and the printing
block, used to completely remove model material from the
system before loading another type of material in the printer.
The cleaning fluid is supplied in model-material cartridges.

The workstation on which Objet software is installed, used
for preparing build trays for production on Objet printers.
(There is no limit to the number of client workstations in the
local network.)

The Objet 3D printer referred to in this guide.

The computer inside the Objet printer that operates it. (This is
sometimes referred to as the “embedded” computer.)

The GUI (graphical user interface) used for controlling the
Objet printer.

Software running on the computer inside the Objet printer,
that controls all printer operations.

The workstation that interfaces directly with the Objet printer
and is typically positioned next to it.

The part of Objet Studio software that manages production
jobs before they are sent to the Objet printer.

Material used for building models.

The software with which users prepare jobs for producing
models.

The extension of a file that contains all of the information
needed for a model-printing job on Objet 3D printers. An objtf
file is used to send a print job to an Objet 3D printer.

The extension of a compressed “wrapper” file containing all
of the files used in an Objet Studio build tray. Using objzf files,
a printing job can be saved as a single file, for convenient
storage and transfer.

The base substance from which photopolymer printing
materials are made for use in Objet printers. In Objet Studio
and printer-application screens, “resin” refers to cartridges of
model and support materials.
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SLC A file type used with Objet software. (These files are bitmaps
of individual slices of the object. For more information, see
page 3-4.)

STL A file type used with Objet software. (For more information,
see page 3-4.)

Support material Material used for supporting the structure of models during
production.
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Safety

Safety Features

Objet 3D printers are designed to comply with CE and FCC standards.
They are equipped with the following safety features:

Cover interlock The power supplied to the UV lamp and the
switch motion motors is turned off when the cover is
opened.

WARNING: Do not defeat (override) the
& interlock switch. Doing so could result in
serious personal injury. If the interlock switch
does not function correctly, do not use the
printer, and contact your service provider.

Cover lock The cover is locked while the printer is
working. It is released when the printer reverts
to pause or stop mode.

WARNING: Do not defeat (override) the
& safety lock. Doing so could result in serious

personal injury.

If the safety lock does not function correctly, do

not use the printer, and contact your service

provider.

UV screen The transparent section of the cover blocks
harmful UV radiation, allowing the operator to
view the model as it is being made.

Circuit breaker The power to the printer is turned off in case of
electrical overcurrent.
Note: The circuit breaker is only accessible to
service personnel.

Grounded chassis  The chassis of the printer is grounded, to
prevent electrical shock.
Note: The power outlet must be properly
grounded, in accordance with the local
electric code, to provide this protection.

UV screen

Cover interlock switch

Circuit breaker

Figure 2-1: Front and back views of the Objet30 printer

If the Objet 3D printing system is not used as specified in this guide, the
safety features may not provide adequate protection.
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Symbols and Warning Labels

This following table lists the warning labels located on or in Objet printers.

DOC-24333 Rev. A

printer.

Warning Meaning Location Comments

Symbol
Hazard On the name plate | Read the instructions
(general) on the back of the | in this document

before operating the
printer.

Hot surface

On the print-head
block.

Risk of burns. Do not
touch this surface
after printing.

High voltage | Near the UV lamp | Risk of electric shock.
connector.
Near the power-
supply enclosures.
Ultraviolet Near the UV lamp. | Risk of injury from
radiation ultraviolet radiation.
Moving parts | On top of the Risk of injury from

printing assembly.

moving parts.

2-3
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Safety Guidelines

Printer

Installation

Printer

Operation

UV Radiation

Printer

Maintenance

3

The following general guidelines, together with the instructions provided
throughout this user guide, ensure user safety while operating and
maintaining the Objet system. If the system is not operated as specified,
the user's safety may be compromised!

» Installation and removal of the printer should only be done by qualified
service personnel.

» Connect the printer to the electric outlet using a power cord that is
safety-certified.

A\

The electric outlet should be easily accessible, near the printer.

» Never connect the power plug to an outlet that does not have a ground
(earth) wire, and never disconnect the ground. Doing so might expose
the operator to serious danger from electric shock.

» Leave a minimum of 20 centimeters between ventilation openings and
walls or other objects.

» The printer should only be operated by persons trained by a Stratasys
customer-support representative.

» All personnel operating or maintaining the printer should know the
location of first aid and emergency equipment and how to use it. Never
block access to this equipment!

A\

Keep fingers and other body parts clear of the printer cover when
closing it.

Never attempt to open the main cover of the printer while it is working!
Never override the interlock safety switch!

If the interlock safety switch ever fails, do not use the printer.

V V V V

Several parts of the printer remain extremely hot even after it has
stopped operating. Avoid touching the UV lamp and the print block.
The UV lamp used in the printer emits dangerous radiation.

» If the UV lamp remains on when the printer cover is open, do not stare
directly at the UV light. Shut down the printer and call your Stratasys
service provider.

» Service operations should be performed only by qualified personnel
who have been instructed in relevant safety precautions.

» Notify co-workers and those who have access to the Objet system
before beginning non-routine and hazardous work.

Report any potential dangers and safety-related accidents to your safety
officer or to other appropriate authorities.

DOC-24333 Rev. A
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Model and
Support
Materials

UV Lamps

DOC-24333 Rev. Al

Model and support materials are made of chemical substances. Although
precautions must be taken when handling these materials directly, all
model and support materials used by the Objet system are handled in
sealed cartridges. Normally, operators of the printer should never be
directly exposed to hazardous materials. In the unlikely event of a leak or
spill, follow the instructions that are included with the printing-material
cartridge used.

» Store model and support materials indoors, in a dry area with adequate
ventilation, between 16-27 degrees Celsius (60-81 degrees Fahrenheit).
Never expose them to flames, heat, sparks, or direct sunlight.

» Keep model and support materials away from areas where food and
drink are stored, prepared and consumed.

» Uncured printing material is considered a hazardous substance,
requiring certain precautions when directly handling it. To prevent skin
irritation, wear neoprene or nitrile gloves. If there is any chance that
model and support materials might splash into the eyes, wear safety
goggles. Prolonged direct contact with printing materials can cause an
allergic reaction.

» When handling UV-cured models that may not be completely cured on
the surface, common latex gloves are adequate.

» To prevent respiratory irritation, ventilate areas where model and
support materials are used. The ventilation system should totally
replace the air at least four times per hour.

» Clean up model-material and support-material spills with disposable
towels or other absorbent, non-reusable material, such as sawdust or
activated charcoal. Rinse the spill area with denatured or isopropyl
alcohol (IPA), followed by soap and water. Dispose of the absorbent
material in accordance with local regulations.

» Do not wash contaminated clothing at home; clothing should be
professionally laundered.

» Dispose of contaminated shoes, belts and other leather items in
accordance with any applicable regulations. Absorbed printing
material may re-expose the user when these items are worn.

UV lamps used by the printer to cure printing materials contain a small
amount of mercury. In the unlikely event of lamp breakage, avoid inhaling
mercury vapor, and ventilate the room. If the lamp ruptures (breaks)
during operation, leave the room and ventilate it thoroughly (for about 30
minutes).

Use protective gloves to prevent contact with mercury and other lamp
components. Carefully remove spilled mercury with a method that
prevents the generation of mercury vapor, such as a syringe, packing tape
or paper.

Place the broken lamp, mercury and contaminated materials in an air-tight,
non-metallic container. Dispose of the container in accordance with
applicable regulations.
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First Aid for Working with Printing Materials

3

Contact with
Skin

Contact with

2—6

Eyes

Ingestion

Inhalation

In general, try to avoid direct contact with uncured printing material. If
skin or eyes come into contact with it, wash the area immediately and
thoroughly with water, and follow these first-aid instructions.

The Material Safety Data Sheet (MSDS) that accompanies printing
materials contains important safety information. Keep this in an accessible
place where these materials are used and stored.

If uncured printing material comes in contact with skin, wash the affected
area immediately and thoroughly with soap and cool water, then remove
contaminated clothing. Pay particular attention to flushing the hair, ears,
nose and other parts of the body that are not easily cleaned.

» Use cool water to prevent skin pores from opening, so that the liquid
material does not easily penetrate the skin.

» Do not use solvents to clean skin.

> If large areas of skin have been exposed, or if prolonged contact results
in blisters, seek medical attention. In any case, if irritation persists, seek
medical attention.

» Avoid the accidental transfer of printing material from the hands to
other areas of the body, especially to the eyes.

> If protective cream was used, do not reapply it until the skin has been
completely cleansed.

If uncured printing material comes in contact with the eyes, flush
immediately with large amounts of water for 15 minutes and seek medical
attention.

> Avoid sunlight, fluorescent light, and other sources of ultraviolet
radiation.

The wearing of contact lenses when handling liquid printing materials is
not recommended. If the liquid splashes into the eyes when contact lenses
are worn, immediately remove the lenses and flush the eyes with water.

» Clean and disinfect the contaminated lenses.
» Do not wear contact lenses until eye irritation disappears.

If printing material is swallowed, refer to the instructions included with the
cartridge. Seek medical attention immediately.

Vapors from printing materials can be irritating to the respiratory system.
If respiratory irritation occurs, expose the victim to fresh air immediately.

» If the victim has stopped breathing, perform artificial respiration or
cardiopulmonary resuscitation.

Seek medical attention immediately.
Keep the patient warm but not hot.

Never feed anything by mouth to an unconscious person.

vV V V V

Oxygen should be administered by authorized personnel only.

DOC-24333 Rev. A
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Waste Disposal

Printing Materials

UV Lamps
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Fully cured printed models can be disposed of as ordinary office trash.
However, special care is required when handling printer waste (uncured
printing material).

» When removing the waste container from the Objet printer, wear
neoprene or nitrile gloves.

> To prevent liquid waste from splashing into the eyes, wear safety
goggles.

» Liquid waste from the Objet printer is classified as hazardous industrial
waste. Therefore, printing-material waste must be packaged and
disposed of in a manner that prevents human contact with it and
contamination of water sources.

» Empty model-material and support-material cartridges contain residue
of their contents. Some leakage of this residue may occur through the
broken cartridge seal. Therefore, handle and store empty cartridges
with care.

Y

Do not attempt to reuse empty cartridges, and do not puncture them.

» Dispose of used cartridges and waste containers in accordance with
local regulations.

» Discard contaminated clothing, shoes, empty containers, etc., in
accordance with any applicable regulations.

UV lamps used by the printer to cure printing materials contain a small
amount of mercury, and are considered “Universal Waste.” Recycle or
discard used lamps in accordance with applicable regulations.

Broken lamps:

After ventilating the area, use protective gloves and carefully remove
spilled mercury with a method that prevents the generation of mercury
vapor, such as a syringe, packing tape or paper. Place the broken lamp,
mercury and contaminated materials in an air-tight, non-metallic container.
Dispose of the container in accordance with applicable regulations.

2-7
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Figure 3-1: The Objet30 3D Printer

Work Configurations

3-2

The Objet 3D printing system can be set up as a single-station system or as
a multi-station system. When connected to a local computer network, the
system can serve multiple users. In such configurations, each user
workstation (client) prepares files with Objet Studio software for
production. A server (host), typically next to the 3D printer, acts as a job
manager that sends production jobs to the printer for production.

Figure 3-2 shows the Objet30 printer set up in a multi-client configuration.
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Client workstations

Y Printer
workstation

Objet server

\VM switch

Objet printer ﬂ

Figure 3-2: Multi-client network configuration

When installing the Objet software, you choose whether to install it as a
client station or as a master station (server or standalone station).

The Objet software arranges the jobs it receives according to their priorities,
model-material type, and other factors. In multi-workstation
configurations, the operator of the server —typically the production
administrator —has total control over the jobs sent to the 3D printer, and
can prioritize and delete jobs, review job history and reprint a job, and so
on.
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Source Files

STL Files

SLC Files

Objet 3D printing systems produce three-dimensional models designed
with most 3D CAD tools and with other job-specific 3D applications. Objet
systems accept:

e STL Files
e SLC Files

Objet systems feature the capability of producing both types of model files
simultaneously.

STL is short for Standard Triangulation Language. This language views any
object as a collection of surfaces, and describes each surface of the object as
a collection of triangles.

For example, a square can be described as two triangles; a cube (six
squares) as 12 triangles. Curved surfaces need more triangles to describe
them. The higher the tolerance (for smooth surfaces), the more triangles are
needed. The result is that high-quality object descriptions mean very heavy
files.

Most CAD software can export STL files. The Objet system utilizes these
files for building models (rapid prototyping), and also for directly making
molds for mass-producing items.

STL files can be ASCII (text) files or binary files. The content of the ASCII
file begins with “solid” and ends with “end-solid” (both lower case).
Between these keywords is a list of the triangles that describes the faces of
the solid model. Each triangle defines a single normal vector directed away
from the solid’s surface, followed by its X-Y-Z coordinates. These are
expressed as Cartesian coordinates and are floating-point values. The
coordinates of all triangles should be positive and should fall within the
volume of the model.

SLC is short for Stereo-Lithography Contour. SLC files describe two-
dimensional contours of the three-dimensional models. These contour lines
are polylines.

SLC files are ASCII (text) files that save models as a series of slices. This
means that models based on SLC files cannot be orientated; only their scale
(size) and position on the build tray can be controlled. For this reason, the
model’s orientation must be suitable for production before it is saved as an
SLC file. Because of the nature of SLC files, the appearance of models in
Objet Studio may be different than the solid-object images displayed from
STL files.

DOC-24333 Rev. A



Objet30 User Guide

Printing Materials

Objet printers produce models by jetting thin layers of printing materials
on the build tray, until the complete model is formed. Two types of material
are used in this process:

* Model material —which makes up the finished model

* Support material —which fills gaps and spaces in the model during
printing, and is removed after printing

Available Different types of Model materials are available for Objet30-series printers,
Materials depending on the printer model.
Printer Model Vero (colors) | VeroClear | Durus | RGD525 | RGD450 | RGD240 | MED610 | MED690
Objet30 Pro v v v v v
Objet30 v v
Objet30 Scholar v v
Objet30 OrthoDesk v v
e Vero

DOC-24333 Rev. A

Materials in this group are suitable for general model making, and come
in a choice of color (white, blue, gray, black and VeroClear™).

All of these materials offer the following features:
O thermo-plastics simulation (appearance and feel)

O high dimensional stability (especially with VeroGray™,
VeroWhitePlus™, VeroBlackPlus™ and VeroClear)

O excellent detail and surface quality
e VeroClear™

VeroClear, available for Objet30-Pro printers only, is a transparent
material simulating PMMA. Its characteristics are the same as other
Vero materials.

* Durus
DurusWhite™ is available, which features:
O polypropylene simulation (appearance and feel)

O enhanced toughness and flexibility —suitable for reusable containers
and other snap-fit applications

e RGDb525
RGD525™ js an off-white material, which features:

O excellent heat resistance (up to 80° C) —parts retain their shape, even
in extreme conditions

O high durability
O fine surface finish
O long shelf life

3-5
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* RGD450
RGD450™ is a general purpose, white material, which features:
O enhanced toughness
O high dimensional stability
O excellent detail and surface quality
* RGD240
RGD240™ is a blue material for Objet Scholar printers, which features:

O Vero-material properties
O suitability for educational (non-commercial) use

* MED

Materials, with Vero-material properties, formulated and approved for
medical and dental applications.

0 MED610™ —clear
0 MED690™ —opaque, peach color

For up-to-date information about Objet printing materials and their
properties, go to http://www.stratasys.com/materials/polyjet.

Materials used for printing models with Objet printers are made of resins,
which are composed of reactive monomers and oligomers. Although
printing materials are supplied in sealed, UV-proof cartridges, care must be
taken when storing and handling them. Follow these guidelines to protect
operators and the environment, and to ensure optimum results.

* To ensure product stability, do not allow these materials to come into
contact with metal. Plastics made from monomer-soluble substances
(such as polystyrene or polyvinyl chloride) are not suitable for storing
Polyjet printing materials.

*  When not in use, keep material cartridges tightly sealed to prevent
contamination, the effects of exposure to UV radiation, and accidental
spillage.

* Store material cartridges indoors, in a dry area with adequate
ventilation, between 16-27 degrees Celsius (60-81 degrees Fahrenheit).
If exposed to heat or flames, cartridges may burst or ignite.

* Signs of premature polymerization in material cartridges may include
bulging, leaking, the emission of heat, and unusual odor. Exposure to
heat can cause resin to gel in the cartridge.

* Make sure that material cartridges are stored in accordance with all
local regulations and other applicable requirements.

Materials used for producing models have a limited shelf life. The expiry
date on the label is valid when properly stored in an undamaged,
unopened cartridge. Always rotate your stock, so that the cartridge with
the earliest date is used first.

If printing materials are not in their sealed cartridges, make sure to shield
them from sunlight and other sources of UV radiation, such as fluorescent
and mercury-vapor lights. Exposure to UV radiation causes an increase in
viscosity and, eventually, solidification.

DOC-24333 Rev. A



Objet30 User Guide

Safety
Considerations

3

Disposal

Before being cured, resins are hazardous materials. To prevent possible
health hazards, follow these precautions regarding printing materials:

* Do not expose to flames, heat or sparks.

* Prevent contact with skin and eyes.

* Ventilate areas where they are handled.

* Keep them separate from food and drink.

Cured plastic parts, however, are safe. They can be handled and stored
without precautions.

You can find more safety information about resins in “Safety Guidelines” on
page 2-9, and “First Aid for Working with Printing Materials” on page 2-13.

Dispose of cartridges of model and support material in accordance with all
applicable laws and regulations. If necessary, the cartridges can be
disassembled for recycling.

Work Environment

DOC-24333 Rev. A

Extreme heat and humidity conditions can adversely affect the operation of
the Objet 3D printer. Therefore, it is recommended that you use ventilation
or air-conditioning systems, if necessary, to keep the work area within the
following ranges:

* 18°-25°C (64°-77° F)
*  30%-70% relative humidity

3-7
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Workstation Requirements

The following tables list the requirements for computer components used
with Objet 3-D printer software.

Requirement

Server workstation:

Computer Type Standard desktop PC (not a portable or all-in-one computer)

Mouse/Keyboard |Server workstation:
Connection USB, PS/2, or RS-232 (wireless components unacceptable)

Processor Intel® Core™ i3 or better

Windows® XP Professional SP2

Operating System | Windows® 7 64-bit?
Professional, Ultimate, Enterprise, Starter, Home Basic,
Home Premium editions

Open GL® with 1 GB of memory or more

For dental applications:
« ATI™ Radeon™ HD 5970, with 2 GB of memory, or
« NVIDIA® GeForce® GTX 285, with 2 GB of memory

Graphics CardP

RAM 8 GB or more?

CD Drive IDE CD ROM

Hard-Disk Drive 80 GB or larger
LAN TCP/IP

NEELAeE e (2 for server workstation; 1 for client workstation)

Video Card Server workstation: VGA connector®
, Resolution: optimum for screen used
Monitor . .
Color quality: 32 bit
Monitor Cable VGA connector®

a. On 64-bit operating systems, Objet Studio runs as a 32-bit application, but it can
utilize up to 8 GB of memory.

b. The following graphics cards were tested in Stratasys labs:
* NVIDIA® Quadro® Family —FX570, EX1700
* NVIDIA® GeForce® Family —6200 TurboCache™, 7300 GT
* Intel® Express Chipset—82915G/82915GV/82910GL, Q965/Q963, Q35,

Q45/Q43, 82852/82855

* ATI® display adapter—Radeon™ HD 5670, Radeon™ E6760

c. The KVM switch requires VGA video connections. If the server workstation
has a DVI video connector, a VGA adapter is needed. The cable from the
monitor must have a VGA connector.
Note: You control both the built-in printer computer and the server workstation
with same keyboard-monitor-mouse set by using a KVM switchbox.
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Preparing Files for Use with Objet 3D Printing Systems

Converting
CAD Files to
STL Format

Converting
Files to SLC
Format
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Before using files with Objet 3D printing systems, you must convert them
in your CAD program to either st files or sic files. (For an explanation of
these file formats, see “Source Files” on page 3-4.)

After converting the model files, it is recommended that you check them for
defects in an STL-repair application (such as Magics™, by Materialise®)
before opening them in Objet Studio and producing the model.

You can print several models or parts at the same time, after arranging
them on the build tray in Objet Studio. The following are the maximum
dimensions for a single model printed on the Objet30 printer:

* With glossy finish—
X-axis: 294.00 mm (11.57 inches)
Y-axis: 192.00 mm (7.55 inches)
Z-axis: 148.60 mm (5.85 inches)
* With matte finish—
X-axis: 293.00 mm (11.53 inches)
Y-axis: 191.00 mm (7.52 inches)
Z-axis: 148.30 mm (5.83 inches)

This procedure may vary slightly, depending on the CAD software used,
but the following instructions generally apply.

To convert a file to STL format (in a CAD program):
1. From the File menu, select Save As.

2. In the Save As dialog box, open the Save As Type pull-down menu and
select *.STL.

3. Click Options and set the following parameters:

* Total Quality —approximately 0.01 mm (deviation tolerance /
linear-dimension tolerance)

* Detail Quality —approximately 5° (angle tolerance)

Note: Lowering these values produces more accurate models, but
results in larger files and longer loading and processing times. For this
reason, it is generally not recommended that you use lower values.

4. In the file format option, choose binary or ASCII. (Both binary and
ASCII formats can be used in Objet Studio. However, binary files are
smaller, so this option is recommended.)

5. Click OK or Save.

When converting files to SLC format, it is recommended that you set a layer
thickness of 15 microns (0.015 mm). Since SLC files cannot be orientated in
Objet Studio, it is important that models are properly orientated before
being saved as SLC files. Considerations for suitable model orientation are
explained in “Model Orientation” on page 5-21.
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Objet Studio Software

3-10

3

Objet Studio software for the Objet 3D printing system consists of two main
screens:

* Tray Settings / Model Settings
* Job Manager

Tray Settings / Model Settings

In the Tray Settings and Model Settings screens, you prepare source files for
production in Objet 3-D printers. Objet Studio offers you a wide variety of
file-preparation options, but always consists of the following basic
procedure:

Inserting one or more objects on the build tray
Positioning the object(s) on the tray

Configuring object and tray parameters

L

Saving the tray configuration as an objtf (Objet Tray Format) file
5. Sending the objtf file to the Objet 3D printer for production

Using Objet Studio to perform these tasks is described in detail in chapter 5,
“Using Objet Studio.”

Job Manager

The Job Manager screen is different for client workstations and for the
computer connected directly to the Objet 3D printer.

* In Objet Studio installed on the directly-connected computer (server),
the Job Manager screen displays the queue and status for all jobs sent to
the 3D printer by the server itself and by all client computers on the
network. All jobs displayed can be edited and manipulated.

* In Objet Studio installed on client computers, the Job Manager screen
displays the queue and status only for jobs sent to a 3D printer server
from that computer. Only these jobs can be edited and manipulated
from the client computer.

Client computers can be connected, via the local network, to different Objet
3D printers, but only to one at a time. The Job Manager screen displays the
status of the 3D printer to which the client is currently connected.
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Installing Objet Software

How to Install Software for the Objet 3-D Printing System

The Objet Studio setup wizard guides you when installing the Objet
software. During installation, you must choose to install either the server
(“host”) application or the client application.

To install Objet software:

1. Insert the Objet Studio CD into the disk drive.

2. Right-click the Start button and select Explore (or use any other method
for displaying files on the computer).

Open the CD-drive folder and select Setup.

4. If you are installing an Objet Studio upgrade, make sure that your
printer is compatible with it by checking the list displayed.

Objet Studio Setup =

B Flease note...

4 This version of Objet Studio is *not™ compatible with the following
versions of the printer software:

- Connex500, 57.0 (and below)
- Connex 350, 37.0 (and below)
- Eden500V, 50.2 (and below)
- Eden350V, 36.0 (and below)
- Eden260V, 27.0 (and below)
- Eden350 (all versions)

- Eden330 (all versions)

- Eden2a0 (all versions)

- Eden250 (all versions)

- Alaris30 (all versions)

If the printer software is incompatible, printing will not be possible
after this Objet Studio installation.
For more information, contact your Objet service provider.

To install Objet Studio, dick OK.

oK I Cancel |

Figure 4-1: Objet Studio compatibility check

5. To install Objet Studio, you must agree to the license agreement. After
reading its terms, click Yes to continue, or No to close the wizard.

If you click Yes, the following screen should appear.

i Objet Studio 9

Welcome to the Objet Studio 9 Setup Wizard

The inztaller will guide you through the steps required to install Objet Studio 9 on your
computer,

WARMIMG: This computer program is protected by copyright law and international treaties.
Unauthorized duplication or distribution of this program, or any portion of it, may result in severe civil
or criminal penalties, and will be progecuted to the maximum extent possible under the law.

[ Cancel ] [ < Back ] [ Mewt > l

Figure 4-2:0bjet Studio installation wizard—Welcome screen

6. Click Next to begin installation.

DOC-24333 Rev. A



Objet30 User Guide

S

DOC-24333 Rev. A

7.

8.

In the Select Features screen, select the required installation option.
Select Objet Studio for a server computer...

® if you are installing Objet Studio on a server (“host”) computer —
the computer directly connected to an Objet printer.

® if you are installing Objet Studio on a standalone (off-line)
computer.

Select Objet Studio for client workstations if you are installing Objet
Studio on a “client” workstation—a remote computer that prepares
print jobs and then sends them to a server computer.

i Objet Studio

Select Features

Select the prefered Objet Studio Installation twpe for your computer

(%) Obiet Studio for a server computer.

() Obiet Studio for client workstations.

[ Cancel ] [ < Back ] [ Mewt >

Figure 4-3: Objet Studio configuration selection

In the Select Installation Folder screen, verify the destination folder and
click Next.

It is recommended that you do not change the default destination folder.

Click Disk Space to check the space in the destination folder.

9.

i Objet Studio 9

Select Installation Folder

The inztaller will install Objet Studio to the following folder.

Ta inztall in this folder, click "Mext. Toinstall to a different folder. enter it below or click “Browse.

Folder:
C:\Program FilestObjetStudio’ Browse...
Inztall Objet Studio for yourself, or for anyone who uses this computer.

Figure 4-4: Objet Studio installation-folder selection

In the Confirm Installation screen, click Next to begin installation.
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10. In the Select Printer Type screen, select the Objet 3D printer used for

producing models.
To continue, click Next.

Select Printer Type

Select an Objet Printer.

() Objet24 () Objet 260 Connex

) Objet 30 Scholar
() Objet 30 OrthaDesk

) Objet 1000

Figure 4-5: Printer selection

Note: For Alaris30U printers, select Objet30.
For Alaris30 Pro printers, select Objet30Pro.

Installation begins and a progress bar appears, showing the progress of

the installation process.

i Objet Studio 9

Installing Objet Studio =~

Obijet Studio 9 iz being installed.

Flease wait...

Cancel

Figure 4-6: Installation progress bar
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When the Objet program installation is complete, the final InstallShield
Wizard screen appears.

i Objet Studio 9

Installation Complete

Obijet Studio 9haz been successfully installed.

Click "Close" to exit.

Cloze

Figure 4-7: Final installation screen

11. Restart the computer to complete the software installation.

Note: Make sure to remove the CD from the disk drive before restarting the
computer.

The installation process ends when the appropriate icon(s) appear on the
computer desktop:
¢ Objet Studio

® Stop Job Manager (for servers and standalone stations)
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Launching Objet Studio

After you install Objet Studio, a launch icon |oe: studo

Windows® 7
Security
Warning
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appears on the

Windows desktop. Open the application by double-clicking this icon, or by

selecting Objet Studio from the Start menu.

Depending on the User Account Control settings in Windows® 7, you may
see the following warning when opening Objet Studio.

r -
Hy) User Account Control ﬁ

O Do you want to allow the following program from an
unknown publisher to make changes to this computer?

Program name:  ObStudio.exe
Publisher: Unknown
File origin: Hard drive on this computer

Change when these notifications appear

%

Figure 5-1: Security Warning

If you click Yes, Objet Studio opens. However, this warning message will
appear each time you open the program, unless you change the User

Account Control settings.

To prevent the warning message from appearing again:
1. Click the link at the bottom of the security warning dialog box (Change

when these notifications appear).

2. Inthe User Account Control Settings screen, move the slider to “Never

Ly
notify.
%) User Account Control Settings O | B |
Choose when to be notified about changes to your computer
User Account Contral helps prevent potentially harmful programs from making changes to your computer.
Tell me more about User Account Control settings
Always notify
-] - Notify me only when programs try to make changes to
my computer (do not dim my desktop)
*  Don't notify me when I make changes to Windows
- - seftings
-
@ Mot recommended. Choose this only if it takes a long
[ time to dim the desktop on your computer.
Never notify
B oK Cancel

Figure 5-2: Changing the User Account Control settings

3. Click OK.
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Objet Studio

Interface

4. In the following dialog box, click Yes.
f '&' User Account Control @

Do you want to allow the following program to make

changes to this computer?

I ;".| Program name:  UserAccountControlSettings
T!' Verified publisher: Microsoft Windows

V Show details Yes ] [ iy

Change when these notifications appear

Figure 5-3: Confirming the change in the User Account Control settings

When Objet Studio opens, the Tray Settings screen appears, showing an
empty build tray.

(S)ttl;jgito Q = ectings : m— Edl - Vo - bt -1 k:ir _u:/l-|e|p
Commands % ) jb“ . \Standard
menu i b - Toolbar
[ Maded 1ree
Active
Quick ribbon
ui
Access
toolbar
Job Manager
tab
Model tree
pane

Faaty HeATH 14 Y5049 Mool 1 nn

Figure 5-4: Objet Studio opening screen

The Objet Studio interface consists of two main screens:

* Tray Settings—for arranging models and preparing them for printing.
This screen is described below.

* Job Manager—for monitoring and managing print jobs.

This screen is described in “Monitoring and Managing Print Jobs” on
page 58.
Each screen is controlled by menus and icons on its own ribbon. An
additional ribbon, Model Settings, displays controls for configuring and
manipulating selected models.

Objet Studio anticipates your workflow by displaying and enabling the
options relevant to your current task. For example, when you first open
Objet Studio, the Model Settings ribbon is disabled until you place a model
on the build tray. Similarly, menu options available from the Standard
Toolbar menus are enabled or disabled to match the current workflow.
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The ribbon, colors used, and several other interface features can be

customized. How to change the appeara
“Customizing Objet Studio” on page 47.

Instructions for using the commands for

nce of the interface is explained in

preparing models for production

and sending jobs to the printer, appear later in this chapter.

Objet Studio
Job Manager
e88 A0 0 A @

Plane MNew Open Save  Undo Redo Single Zoom Tsometric

View ~ Tray -

Build Process Selection File Edit Vit

Figure 5-5: Tray Settings ribbon

= ObjetStu... Wrench Key

Model Settings

® W e @ a @

Tray Settings Job Manager

go Cut %S Val

-«

% 15590 [ Uniform Scale| | mm
e
Fillmeter

.= x
Edlt - View + Object - Tools ~ Styls + @) *
By
Material= || Fullcure7z0 -
Colors Currently Ioaded: FulCure?20 Estimatss are nok available.
=, X

Edit ~ Yiew - Object ~ Tooks - Styls - (@) -

ﬁo < #

9000 Delete Undo Redo | Plane || Maove Transform Lock Single Zoom Isometric || Vi |49.66 |Matte |Glossy Advanced By
Paeka = View s Tray~ - 7 1020 Material -
Edit Selection Manipiilate Vi Dimensions (mm) Units Options Colors

Figure 5-6: Model Settings ribbon
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Ribbon The following table lists the Tray Settings and Model Settings ribbon
Commands command groups, and shows when they are enabled, and where they
appear.
Group Purpose When Tray Model
enabled Settings  Settings
Ribbon  Ribbon
Setting display | Always.
g%% colors.
: J | v
Material =
Colars
ﬂ OL Selecting q h}/{o%elsl are on
ti t ild tray.
Single: Zoom Egésrﬁelgéée an € bulid fray d d
Wigy = Tray =
Yiew
| Choose to select | Models are on
Plat:e a plane. the build tray. d d
Selection

i

a
‘a@

=

a=zmh

Change the
perspective of
the active pane.

Models are on
the build tray. d

Assigning model
material.

¢ Build tray

is empty. d

Werowhite
* Models are
Loaded material: Verowhite
not
selected.
Val Undoing or After an
e redoing actions. | action or d r
Undo Redo .
obI]ect
= selection.
Edit
veroiithite: 4.0 Estimating the | Build tray is
SuEp 20,0 amount o not empty. d
O printing
Building Time: 01:25 .
o . materials
Estimated Consurnptions required.
3 : Opening and Models are
{,;r saving tiles. not selected. d

Mew Open Save

File
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Group Purpose When Tray Model
enabled Settings Settings
Ribbon  Ribbon
%) Placing model | Always.
files on the build d
Insert tray.
Madel
M % o &’ Pre-build/build | Models are on
w YO commands. the build tray. d
Placement Validabe Estimate Build
" o Scalay Setting model | A model is
1416 dimensions. selected. d
2101
Dimensions {rmm)
4 Cut %_\ e Cutting, A model is
e copying, pasting | selected.
4 Copy ) Delete Undo  Redo and de?e ting d
Pt models.
Edit
T @ 41 Moving, rotating | A model is
= b B and resizing selected. d
Move Transform  Lock models.
Manipulate
DD Assigningmodel | A model is
| P finish an selected. d
y Advanced N
setting support
strength/
Sptions “hollow.”
g Setting amodel’s | A model is
T unit of measure | selected. d
o (millimeters or
. inches).
Lnits

Studio action.

To quickly identify an icon, move the cursor over the icon to display its
tooltip. The “Undo” and “Redo” tooltips change to reflect your last Objet
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Objet Studio
Commands
Menu

Model Tree
Pane

5-8

Clicking the Q icon in the upper-left corner opens the Objet Studio
Commands menu. This menu displays basic application commands and
options.

Ve LA EESL

\?3/' Hew Recent trays
> 1 testiengn
é‘ Qpen,..
2 Trayad
é Save

3 Ci\Program Filesy.. \Trayss

é Save As...
n@ Save Bitmap. .. Ctr+B

?g@. Impart Packed Job,..

@ Export Packed Job. ..

.@;‘ Build Properties. ..

4 C:\Program Filesy.. .| Trayl

djz| User Preferences. .

ri Printer Properties...

Restart

Figure 5-7: Objet Studio Commands menu

The Options button opens a dialog box for customizing Objet Studio.

Appearance || Grid | Manipulate | Display | Settings
Automatic: Placement

Guick Automatic Placement after adding new object

Prezerve 1 mm  distance between objects

Automatic Lay On [Gravity]

O Mever
(@) Ahways
(O \When under the tray

Large Filez
() Load Ful
(O Load Partial (reduced)

Load Search Order
O Local
(&) Driginal

[ Ok H Cancel ]

Figure 5-8: Options dialog box

The Model Tree pane lists the objects placed on the build tray. By default,
the pane “floats” — that is, you can move it to another position on the
screen and resize it. Alternatively, you can fix its position at the left of the
application window, and even hide it.
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Preparing Models for Production

OBJDF Files:
Overview

Model Files

Placing
Objects on the
Build Tray
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Model preparation involves the following basic steps:

1. Place objects on the build tray.

2. If necessary, manipulate the object’s orientation and position.

3. Select the material and model finish.

An objdf file describes both the geometry of a single object and the material,
and finish required to print it. You can use this file format to save a group

of separate objects on the build tray as one unit, together with their relative
positions and material.

Further explanations of files, and their features, appear throughout this
chapter.

To produce models, you open one or more model files in Objet Studio and
position objects on the build tray. You can place objects on the build tray in
two ways:

* by inserting individual st! or slc files.
* Dby pasting objects that you copied to the Windows clipboard.

If you know what type of model material will be used to produce the
models, make sure it is selected from the material drop-down menu.

—
Curusiihite -

[ ] Durushhite
. YeroBlack
|:| YeroBlue

|:| Werorey
[ ] verowhite

Figure 5-9: Model material selection toolbar

Note: Itis not necessary to select the Model material now, but it is
recommended—each type of material has unique characteristics
that may affect the valid positioning of objects on the build tray. The
material selected can also affect printing time—printing with Objet
VeroClear takes longer than printing with other materials.

To place an object on the build tray using stl, slc or files:

Open the Insert dialog box—

* From the Object menu, select Insert.
or—

* On the Tray Settings ribbon, click nsert .
or—

* Right-click on the build tray, and select Insert from the context
menu.
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5-10

The Insert dialog box appears.

Documents

Desklop

_JSTL Fles
i Text30
L Trayl
My Documents
)
wd
Iy Compuber
- File name: sample file bt
My Metwork  Files of bppe: STL Fiies [“.5t) v | Cancel
Units: Militater bt
Number of Copiez: |1 > D [#] Diert Automaticale

Lock in: | (=3 Samples vl QX E
5 (JBasi Shapes
L) (Do
iy Recent JConnex Samples

) Connex_Samples
JIEden_alaris_Samples
Cilmages

I5LE Files

Coordnales
Width (] Depth(Y] Hexght )
Etents 229 5o2ae 229

[¥] Prenview

Figure 5-10: Insert dialog box

In the Look in field, display the appropriate folder.

In the Files of type field, select the file types to display (stl, slc, objdf).

Select the desired file, and make sure that it appears in the File name

field.

If the Preview check box is selected, the object is displayed in the dialog
box, as shown in figure 5-10.

The Model Settings ribbon is displayed when objects are placed on the
build tray.

Note:

Select any of the following options, as required:

Units —Millimeters or inches for the object’s units of measure.

The 3D file contains the object's proportions, but not its units of
measure. Therefore, make sure to correctly select either millimeters
or inches when inserting an object. Otherwise, the size of the object
on the build tray will be either much too large or much too small. To
change the measurement units of objects already placed on the tray,
see “Measurement Units” on page 25.

Number of copies —How many copies of this object to place on the
build tray.

Orient Automatically — Automatically orient objects on the build
tray for efficient model building.

The Extents values displayed in the Coordinates section of the Insert
dialog box, represent the maximum dimensions of the object on each
axis. These dimensions correspond to the virtual “bounding box”
surrounding the object see figure 5-36 on page 31).
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6. Click Insert.
Objet Studio places the object on the build tray, and in the model tree.

'@_‘bbét B Poket Cond okt Objet Studia -
] B - Yew v Qhject < Tesk o Sl v R -

P o o B T . E*m@'.a«x B & | &
By

DS  Deetn ndo [k | Pbne | Hove Tramfom ook |7 lersy Advarced W Zeom
= ;m Wews  Taye || Hetwise

Seloction Maripulste Cmensions (mm)

Model
Toolbar

_ M 1 ) 3050 T 5,57 _Hodelsi | L

Figure 5-11: Default screen layout

The Model Settings ribbon is displayed when objects are placed on the

build tray.

If the object is over a certain size, the Loading Placed Elements dialog box
may appear.

Loading Placed Elements |g|

todel Mame IE:H...'\GHender'\B inhTray] obitf

I ]

Placed Elerment IE:'\...'\testI:uuiId.u:uI:uidf

I ]

T Ef}R}R}TE
Figure 5-12: Loading Placed Elements dialog box

You can speed up the opening of large files by changing the Large Files
settings—see “Loading Large Files” on page 35).
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Opening files

Before placing files on the build tray, Objet Studio must extract the

component stl files together with information about their relative position
and model materials. To do this, Objet Studio creates a folder with the same

name as the file, in the same location.

Look in: | I Samples

@.

My Recent
Documents

=

Desklop

2>

My Documents

My Computer

by Metwork,

|C5)Basic Shapes
() chess

|C5) Connesx Samples
|C5) Connes_Samples
[C)Eden_alaris_Samples
@Images
I5)sample File
[C)5LC Files

[C3)5TL Files

(5 TextaD
@Trayl

ray |

File name: |Tray1

v

[ Inzert ]

Filez of type: | Obijet Digital Files [* objdf]

]

[ Cancel ]

Urits:

Millitd eter v

Mumber of Copies : |1 e

Coordinates
Wwidth (<] Depth [v)
Extents

I aterials

Height [£]

[] Orient Automaticaly

Packed Azzembly File
Wercwhite

Preview

Figure 5-13: Insert dialog box (file)
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Opening Objet
Tray Files

S
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You can open trays that were saved as objtf files. This is useful, for example,
if you saved a tray after preparing it for printing, and now you want to
make changes before printing it.

To place an object saved as an Objet Tray File (objtf) file on the build

tray:

1. From the File group, click open.

or—

From the Objet Studio Commands, select Open.

The Open dialog box is displayed.

Bk
Look in' [ 3 Basic Shapes v o2 @
y e
) G
My Recent
Documents
€
Deskiop
My Documents
—
-]
5l
My Computer
‘_‘] File rame: Tray1
2
My Network  Files of type Obiet Tray Files (%.obitf) -
Coordinates
[#] Pravisw

Figure 5-14: Objet Tray File Open dialog box

2. Select the desired file, and make sure that it appears in the File name

field.

If the Preview check box is selected, the object is displayed.

3. Click Open.

Objet Studio opens the tray file.

The obijtf file is actually a file containing instructions for printing—which stl
files to print and their position on the build tray. Because the obijtf file
references the stl files used, they must remain in the same file location as

when the objtf file was saved.
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STL file loading  If there are identically named st! files in more than one location, you need
preference to ensure that the correct component st/ files are linked to the objtf file. For
example, if there are identically named st/ files on one drive and on a flash
drive (this can occur if you copy the original files to a working folder), you

can set the default location from which files are loaded.

To set the Load Order:
1. From the Tools menu, select Options.

or—

In the Objet Studio Commands Menu, click Options.
2. In the Options dialog box, display the Settings tab.

Appearance || Grid | Manipulate | Display | Settings
Automatic: Placement

Guick Automatic Placement after adding new object

Prezerve 1 mm  distance between objects

Automatic Lay On [Gravity]
O Mever

(@) Ahways
(O \When under the tray

Large Filez

() Load Ful
(O Load Partial [feducad

oad Search Order
O Local
(&) Driginal

[ Ok H Cancel ]

Figure 5-15: Options dialog box, Settings tab

3. Under Load Search Order, select an option:
* Local—to load files from the location where they were last saved.
* Original —to load files in their original location.

4. Click OK.
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Quick-Access You can access common commands for working with objects on the build
Model tray with the convenient Model Toolbar and context menus.
Commands

Model Toolbar Select an object in the tray to display the Model Toolbar that contains icons
to perform common tasks.

Figure 5-16: Model Toolbar
The table below describes the Model Toolbar icons.

Icon Description
'J Applies a matte finish to the model.

B Applies a glossy finish to the model.
o

- Opens the Advanced Properties dialog box for setting the
‘ﬁ{ Grid Style and the Hollow option.

-::E;‘ Enables dragging an object (see page 5-26).

-

o Opens the Transform dialog box for changing the

:I’; object’s position and scale.

= Toggles the Lock Model Orientation setting.

Right-click model If you right-click on an object, a pop-up context menu is displayed from
menu  which you can also select the model finish, change its position and scale,
and set the Grid Style and Hollow options.

You can also create a Quick Access toolbar with your most commonly used
icons grouped together. See “Creating a Quick Access Toolbar” on page 47.
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Copying and
Pasting
Objects

5-16

If you need to duplicate objects on the build tray, you can insert the same
object from its file more than once. An easier way, however, is to copy and
paste the object. You can copy objects from the build tray or the model tree.
The objects copied remain in the Windows clipboard until you paste them
onto the build tray.

You can also copy objects from one tray and paste them onto another, in the
same way as you copy text from one document and paste it into another
one. However, Objet Studio allows only one tray to be open at a time. For
each build tray you need to work with (at the same time), you must open a
separate Objet Studio window, by running the application again (from the
Windows Start menu).

Having multiple Objet Studio windows open can be convenient when you
need to manipulate or configure objects before inserting them in your
production build tray. Copying and pasting also allows you to use objects
already configured on previously-used build trays for newer projects.

You perform the Copy and Paste commands as in other Windows
applications:

* from the right-click context menu.
* by using keyboard shortcuts (Ctrl+C and Ctrl+V, respectively).

The Paste Special command (from the object’s right-click context menu)
enables you to place duplicate objects even more efficiently:

* You can specify the number of duplicates to place on the build tray at
once.

* You can set the distance, on each axis, between the duplicate objects.

* You can manipulate mirror images of the original object, and flip them
on selected axes.

X]

Paste Special

Mumber of Copies E
Delta
= 100 Y 100 Z |0 rirm
M anipulate
Mirrar [ I [N =
Flip [ ES 1y [z
[ ]5ave as Defaults [ ] l [ Cancel

Figure 5-17: Paste Special dialog box
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Selecting
Objects

Surface Finish

DOC-24333 Rev. A

To manipulate an object on the build tray or assign characteristics to it
(building style, for example), you must first select the object. You select an
object by clicking it, either on the tray or in the model tree. Its image on the
build tray changes color (to light blue, by default) and its name is
highlighted in the model tree. You can select multiple objects by drawing a
box around them with the mouse cursor, or by pressing the Ctrl or Shift
keys while clicking additional objects.

Alternatively, select or de-select objects using the following Edit menu
commands:

* Select All
* |nvert Selection
* Undo Select object

Edit = Wjew + Ohject -

4 undo Select object

Select All
Invert Selection
Figure 5-18: Edit menu
Models can be printed with a matte or glossy surface finish. To create a

matte finish, the printer surrounds models with a thin layer of support
material.

To set the model finish:

1. Select the model.

2. Select Matte @ or Glossy @ in one of the following places:
*  Model Settings ribbon, Options group
* Model Toolbar
* right-click context menu (when selecting the model)

You can configure Objet Studio to distinguish between objects” surface
finish on the build tray by color. To configure how Objet Studio displays
objects, see “Setting Object Colors” on page 34.
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Positioning Objects on the Build Tray

To produce models efficiently and with the required finish, it is important
to carefully position objects on the build tray. Objet Studio supports the
automatic positioning of objects. However, you should check to make sure
that the objects are orientated logically for your needs, according to the
considerations explained in “Model Orientation” on page 5-21.

Automatic
Orientation

5-18

W=

Two things that affect the positioning of objects on the build tray are
orientation and placement. You can let Objet Studio determine the optimum

orientation and position, or you can control them.

By default, Objet Studio automatically orients objects, when placed on the
build tray, for the shortest printing time. (You can later change the
orientation manually.) However, you can cancel automatic orientation
when placing an object on the build tray.

To place an object on the build tray without automatic orientation:

> In the Insert dialog box, make sure Orient Automatically is not selected.

Look ir:

A
16)
My Recent
Documents

Desktop

My Documents

w8
My Compiter
<

-
My Network

2 x|
3 Samples ¥ O3 =
(9Basic Shapes
(iChess
) Connex Samples
() Connex_Samples
Eden_laris_samples
Chlmeges
Ssample file
L)5LC Files
IE3)STL Files
2 Textad
S)Trayt
B Trayt
File nare Tiayl v Insert
Files of type: Obiet Digital Files (*.obid) v
Uit [ Milibster v

Nurber of Copies : |1 2 €O orient Automaticaly

Coordinates

Width <] Depth[v) Height [2) -
Extents
Materials - i
Facked fssembly File ;

Werdvw/hite
Preview

Figure 5-19: Orient Automatically option disabled

You can change the default setting, so that automatic orientation is not
applied unless you select the Orient Automatically check box each time you
place an object on the build tray. To do this, see “Default Settings” on

page 53.
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Automatic After placing several objects on the build tray, you can let Objet Studio

Placement arrange them on the tray for printing. This ensures that the objects are
positioned properly, and that they will be printed in the shortest time and
with a minimum of material.

To automatically arrange objects on the build tray:

» On the Tray Settings ribbon, click Placement .
or—
From the Tools menu, select Automatic Placement.

The effects of automatic positioning are shown in the figures below.

Figure 5-21: Tray arrangement when applying automatic placement

Settings ribbon, even if you inserted the objects with the Orient
Automatically option.

* The physical characteristics of each type of model material you use can
affect the positioning of objects on the build tray. Therefore, select the
material before running Automatic Placement.

% * For best results arrange the tray with Automatic Placement, on the Tray
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Manual You can change the position of objects on the build tray —even if they were
Positioning inserted with the Orient Automatically option. Considerations for
positioning objects are presented in “Model Orientation,” below. Tools for

changing the position of objects are presented in “Manipulating Objects on
the Build Tray” on page 5-22.

5-20 DOC-24333 Rev. A



Objet30 User Guide

Model Orientation
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The orientation of models on the build tray affects how quickly and
efficiently they will be produced by the 3D printer, where and how much
support material is used, and whether or not model parts will have a glossy
finish. Therefore, you should consider a variety of factors when deciding
how to place models on the tray, using the following positioning rules.

X-Y-Z Rule
This rule considers a model's outer dimensions.

> Since the print heads move back and forth along the X-axis, the printing
time along this axis is relatively short, compared to printing time along
the Y-axis and Z-axis. From this point of view, it is advisable to place the
object's largest dimension along the X-axis.

» Any surfaces that come into contact with support materials become
matte.

» Since models are built up, on the Z-axis, in 30-micron layers, it is very
time-consuming to print a tall object. From this point of view, it is
advisable to place the object's smallest dimension along the Z-axis.

» Since the print heads measure about 2 inches (5 centimeters) on the
Y-axis, models measuring less than this (on the Y-axis) are printed in
one pass. From this point of view, it is advisable to place the object's
intermediate dimension along the Y-axis.

Tall-Left Rule

This rule considers models where, after being orientated on the build tray
according to other considerations, one side is taller than the other.

» Since the print heads move along the X-axis from left to right, taller
sections on the right require the print heads to scan unnecessarily from
the left until reaching them. If, on the other hand, the taller sections are
positioned on the left of the tray, the print heads only have to scan the
model until printing these sections—once the lower parts have been
completed. Therefore, you should position the taller side of the model,
when possible, on the left.

The following rules are based on the fact that support material is not
required on the top of the printed model.

Recess-Up Rule

This rule considers models containing surface recesses.

» Recesses in the surface (like hollows, drill holes, etc.) should, when
possible, be positioned face-up.

Fine-Surface Rule

This rule considers models that have one side on which there are fine
details (like the keypad side of a telephone).

» The side of the model containing fine details should, when possible, be
positioned face-up. This results in a smooth finish.
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Avoid Support-Material Rule

This rule considers models that have large holes or hollows, open on at
least one side (like a pipe or a container).

» It may be advantageous to print a model standing up, so support
material does not fill the hollow, even though printing the model lying
down would be much faster.

Manipulating Objects on the Build Tray

Positioning
Objects on the

Z-Axis

5-22

S

When you use the automatic positioning option to arrange objects on the
build tray (see “Automatic Orientation” on page 5-18), the objects are
positioned directly on the tray. If you do not insert objects with automatic
positioning, they often appear either above or below the tray.

In practice, the Objet system prints all models on the build tray on a one-
millimeter bed of support material. The importance of positioning objects
directly on the build tray with Objet Studio is to correctly display the objects
on the screen.

To position objects directly on the tray:

1. Select the object.
2. From the Object menu, select Lay On.

To ensure that objects are always positioned directly on the tray:
1. From the Tools menu, select Options, and display the Settings tab.

Appearance || Grid | Manipulate | Display | Settings
Automatic: Placement
Guick Automatic Placement after adding new object

Prezerve 1 mm  distance between objects

prertmatic Lay On [Gravity
O Mever

(@) Ahways
() \When under the tray

Large Filez

() Load Ful
(O Load Partial (reduced)

Load Search Order
O Local

(®) Original

[ Ok H Cancel ]

Figure 5-22: Options dialog box, Settings tab
2. Inthe Automatic Lay On (Gravity) section, select Always.
Other Z-axis options (in the Automatic Lay On section):

* When under the tray —The display of objects that are below the build
tray is automatically changed so that the object is at tray level.

* Never—The display of objects that are above or below the build tray is
not changed.
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Valid Object
Placement

3
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You can ensure that models do not overlap when you position them on the
build tray, and that they do not extend beyond the tray.

To ensure valid object placement:

1. From the Tools menu, select Constraints Settings.

| a‘
Constraints
Colars
Default Color
Outzide Tray
Callision

Bath

iin

Dynamic check
when to check

(® On Diop
(O \while Drag

Wwhat to check
Outside Tray
Object Collizion

Figure 5-23: Constraints Settings dialog box
2. Select Dynamic check to identify:
* invalid object placement while placing objects —On Drop selected.
* invalid object placement after moving objects —While Drag selected.
* objects placed beyond the tray’s boundaries —Outside Tray selected.
* objects that overlap—Object Collision selected.
Even if you do not use Dynamic Check when placing objects on the build
tray, Objet Studio automatically checks if there is a problem with the
positioning of objects on the tray before sending it to the printer. You can

also manually check for problems after positioning objects (see “Tray
Validation” on page 38).

Note: Remember that Objet Studio calculates the space occupied by an
object including the “bounding box” surrounding it (see figure 5-36
on page 31).
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Usinga Grid to Displaying a grid on the image of the build tray can be useful when

Position positioning objects. To use the grid features, select the following menu
Objects options.

Menu Option Result

Tools > Grid Displays a grid on the build tray.

Tools > Snap to grid | When moving the object, it aligns with the nearest

grid line.
Tools > Options > Enables you to change the grid origin
Grid (X- and Y-axis meeting point) and appearance.

You can review and configure grid settings—and apply them —from the
Options dialog box.

To view and change grid settings:
1. From the Tools menu, select Options, and display the Grid tab.
The current grid settings are displayed.

Options §|

Appearance | Grd Manipulate | Display | Settings
[ Display arid
[15napto grid
Colors

Tile zize 20 | mm

= Base -
Maiar divisi 10 = i

ajor division v | tiles Bt -

Mumber of tiles |32 E

= Majar -
Line style Dot
Uritz Millitd eter v
Oigin [0 3o 2o < |mm

u].9 Cancel

Figure 5-24: Options dialog box, Grid tab

2. Asrequired, change the settings, and select or clear the check boxes.
3. Click Apply or OK.
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Measurement
Units
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3D files contain an object's proportions, but not its units of measure.
Therefore, make sure to correctly select either millimeters or inches when
inserting an object. Otherwise, the size of the object on the build tray will be
either much too large or much too small.

To set the measurement units when inserting an object:
» In the Insert dialog box, Units field, select Millimeter or Inch:

Insert

Look, in: |L'f)SampIes v| Q ¥ m-
Y |L5)Basic Shapes
4 :3 () chess

My Recent I Connesx Samples
Documents |23 Connes:_Samples
— [C)Eden_alaris_Samples

F
|— @Images
Desktop | |)sample file
[C5LC Files
; [C5TL Files
"_/' [ Text3D
My Documents DiTrayt )
@ sample file
My Computer
_ File name: | A | [ Insert ]

My Metwark, Files of type:

Cancel

Figure 5-25: Units field in the Insert dialog box

To change measurement units for a selected object from the
Model Settings ribbon:

1. Open the Units flyout toolbar.

mm
=

Millimeter

-

@ its

nch
-

Figure 5-26: Units flyout toolbar
2. Select the measurement units desired.

To change measurement units for a selected object from the Standard
Toolbar:

1. From the Object menu, select Change Units.

killitd eter
Ihich

Figure 5-27: Model Units dialog box
2. In the Model Units dialog box, change the setting and click OK.
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You can change an object’s dimensions by changing its size on the X-, Y-,
and Z-axes, from the Dimensions group on the Model Settings ribbon.

¥ 360 % Unifarm Scale

i 416
£ 101

| Cirnensions () |

Figure 5-28: Dimensions on the Model Settings ribbon

* If Uniform Scale is enabled, changing the object’s dimension on one axis
affects the other dimensions, proportionately.

* After changing a measurement, press Enter or click in another filed in
the Dimensions group.

Note: You can change the height of the objects on the build tray only if this
is allowed by the Objet Studio settings (see “Positioning Objects on
the Z-Axis” on page 5-22).

You can manually move and rotate an object on the build tray with the

arrow keys, or by dragging it with the mouse.

To manually manipulate an object:

1. Select an object by clicking it on the build tray, or in the model tree
pane.

2. Click wave on the Model Toolbar, or on the Model Settings ribbon.

A frame appears around the object, and the cursor changes to indicate
that the object can be moved.

Figure 5-29: Manually moving an object
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3. Ifyou click on a corner of the frame, the cursor changes to indicate that
the object can be rotated.

Figure 5-30: Manually rotating an object
4. Manipulate the object with the arrow keys or with the mouse.

You can make precise changes to an object by changing the properties in the
Transform dialog box.

To access the Transform dialog box (when an object is selected):
* Click ﬁ; on the Model Toolbar or on the Model Settings ribbon.
* From the right-click context menu, select Transform.

* From the Object menu, select Transform.

Transform rz|

idth(x) Depth(t] Height(Z)

. -
Translate.| 0 v|

-

u;|

|
Fotate: | [ | [
|

Scale: |‘I e 1 :|

Cancel Actions

Figure 5-31: Transform dialog box

To change an object with the Transform dialog box:

» Change any of the values, then click Apply to see how the object
changes on the build tray.

Note: The changed values remain in the dialog box after clicking Apply.
Therefore, you can make small changes to values in the dialog box to see
how the object changes on screen each time you click Apply.

To reset all of the values in the dialog box:
» Click Reset.
Note: The object does not change. Any changes previously applied remain.
To undo all changes made with the Transform dialog box:
» Click Cancel Actions.

After closing the Transform dialog box, clicking Undo (on the Model Settings
ribbon or from the Edit menu) cancels all changes made with the dialog box.
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There are several methods for changing the orientation of objects on the
build tray.

To rotate an object:

> Select the object and use the Object menu options (see also

To re-align an object’s plane: +*
1.

“Repositioning Objects” on page 5-26).
Flne
On the Tray Settings or Model Settings ribbon, click e .
or—
From the Tools menu, select Plane Alignment > Select Plane.
Click on part of an object on the build tray.

The selected plane is displayed.

Alignment
toolbar

Selected
plane

Figure 5-32: Aligning by plane

On the Alignment toolbar, click an appropriate icon to change the
alignment.

or—

From the Tools menu, select Plane Alignment, and select an alignment
option.

| Plane Alignmenk k -E Select Plane
Professional Mode L'{' Align Battom
TirmeMaterial Estimation "} S iz
assembly Map ... i Align Front
%0 Align Back
LEEN=EfEn: S Align Left
Lptions. . o align Right

Figure 5-33: Tools menu, Plane Alignment options
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To cancel plane selection after re-aligning objects on the build tray:

.z-li_.J
Flane
» On the Tray Settings or Model Settings ribbon, click e -
or—
From the Tools menu, select Plane Alignment > Select Plane.
To flip an object 180 degrees on any axis:
1. Select the object.

2. From the Object menu, select Flip > Flip X/ Flip Y / Flip Z.

To make precise changes to the object’s orientation on any axis:

1. Select the object.

2. Display the Transform dialog box (see figure 5-31 on page 27).

3. Change the Rotate parameters for each axis.

If you manipulate an object on the build tray, you can freeze its orientation

so that it does not change when you position it automatically (see
“Automatic Placement” on page 5-19).

To freeze an object:
1. Select an object on the build tray.

2. On the Model Settings ribbon, in the Manipulate group, or on the Model
Toolbar, click & .

To unfreeze an object:
> Select the object and click & (to de-select it).
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Display Options

Viewing From the View menu, you can change the way objects are displayed. The
Objects default method for displaying models on the build tray is as solid
(“shaded”) objects.

Figure 5-34: Tray and model displayed in Shaded view

The other display options are WireFrame and Points.

To display the build tray in WireFrame view:

» From the View menu, select WireFrame.

==

Figure 5-35: Tray and model displayed in WireFrame view

To revert to the shaded view:

» From the View menu, select Shaded.
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To display objects as boxes, showing their maximum dimensions
instead of their shape:

» From the View menu, select Display Bounding Box.

-:-:.:_

Figure 5-36: Model displayed with bounding box

To display the area around objects needed for support material (to
produce a matte finish):

» From the View menu, select Display Thickening Box.

Figure 5-37: Model displayed with thickening box

To display the maximum build height:
» From the View menu, select Display Tray 3D Box.

Figure 5-38: Tray 3D Box

To display objects without the build tray:
» From the View menu, clear (de-select) the Display Tray option.
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Screen Layout  Objet Studio automatically adjusts the default screen layout to display the
optimum views of the build tray and the model tree. You can view models
from different perspectives by changing the screen layout.

To change the screen layout:
> On the View flyout toolbar, select Single View, or 4 Views.

Figure 5-39: Screen layout icons

O Single View |[[/| is the default screen layout.
3 4 Views displays perspective, top, front and right views.

Model Tree

= ) Trayt

| Assambly_Sample_Shell3

Figure 5-40: Single-view screen layout

. paripecthe

Figure 5-41: 4-view screen layout
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The default perspective of the build tray is “isometric.” You can change the
perspective of the active window with one of ten options.

To change the perspective of the build tray in the active window:
1. On the Tray Settings ribbon, open the Perspective flyout toolbar.

Isometric

Figure 5-42: Perspective flyout toolbar

2. Click the icon that represents the desired perspective.

To view the tray and models from different directions, you can move the
tray around the screen and change its display angle.

To move the tray in the Objet Studio screen:

» Press the mouse wheel while moving the mouse.

Figure 5-43: Tray after moving it in the Objet Studio display

25 T e T e—n e

5-33



Using Objet Studio

Setting Object
Colors

5-34

To manually rotate the tray:

> Press Alt and press the mouse wheel while moving the mouse.

9
> \
o

BP0 62 EmL Mol | M

Figure 5-44: Tray after rotating it upside-down

The color of objects on the build tray can indicate how they are printed.
Objet Studio enables you to choose the color display so that you can easily
see the material, and surface of objects.

To choose how colors are applied on the display:

» On the Model Settings ribbon, in the Colors group, select one of the
options from the flyout toolbar.

®

ik Color indicates Model material

Material -
@ﬁ/ Color indicates Model surface
EELPLE

==

®

=

Figure 5-45: Colors display options

Before sending a build tray to the printer, or when you perform tray
validation, Objet Studio checks if there is a problem with the stl files or the
positioning of objects on the tray. If so, the affected objects are displayed
with special colors (see “Tray Validation” on page 5-38).
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Loading Large  Very large stl files can be slow to load and may be difficult to manipulate

Files easily on the build tray. If this is the case, you can display just an image of
the object on the build tray without loading the entire file. The st! file itself
is not changed, and the complete file is sent to the printer.

To display an image of stl files when you place objects on the build tray:
1. From the Tools menu, select Options, and display the Settings tab.

Options x|

| tppearance | Grid | Manipulate | Display | Settings |

Automatic Flacement

Quick Automatic Placement after adding new object

Preserve mm  distance between objects

Automatic Lay On [Gravity)
O Never

(@) Abways

OWhen

Large Files

O Load Full
(&) Load Partial (reduced]

Laoad Search Order

© Local

Apply
Figure 5-46: Options dialog box, Settings tab

2. In the Large Files section, select Load Partial (reduced).

Large File If you need to work with a detailed model that is composed of a large

Manipulation number of polygons, you can speed up its display and manipulation in
Objet Studio by reducing the number of polygons on the screen. Although
this may reduce the resolution on the screen, it has no affect on the printed

models.

Figure 5-47: Object displayed without polygon reduction

Figure 5-48: Object displayed with only five percent of its polygons showing
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To use polygon reduction:
1. From the Tools menu, select Options.
or—
In the Objet Studio Commands Menu, click Options.
2. In the Options dialog box, display the Display tab.
Options X

Appearance | Grid Manipulate | Display | Settings
[[] Enable Polygon Reduction

Display while changing wiew
(%) Bounding Box

() Entire Object

Diigplay when static view

) Bounding Box
(®) Entire Object

Save Polygon Reduction Data

Figure 5-49: Options dialog box, Display tab

Select Enable Polygon Reduction.

Select Polygon Reduction (Percent).

Enter the percentage of total polygons to display.
When you click Apply, the display changes.

Note: The setting affects the static display (when the object is not being
moved).

6. Set display options when the object is being moved (Display while
changing view):

* Bounding Box— A box representing the object’s maximum
dimensions is displayed.

* Adaptive Polygon Reduction —Varying degrees of polygon reduction
are applied, as necessary.

* Entire Object—No polygon reduction is applied.

7. To save these settings, so that they will be applied every time you place
this object on the build tray, click Save Polygon Reduction Data.

8. Click Apply to see the results of the settings without closing the dialog
box.

% Selecting the Entire Object option cancels polygon reduction.

Object display The display format affects how quickly objects display. For example, if you
options  select Bounding Box, objects display faster than they do when you select
Entire Object. You can choose display formats for objects when they are
stationary (static view) and for when you are dragging them (changing view).
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To select the object display preference while changing view, and in static
view:
1. Select to display objects:
* With a Bounding Box (see figure 5-36 on page 31)
*  With Adaptive Polygon Reduction (changing view only)
*  With Polygon Reduction (static view only)
* Entire Object
2. Click OK when done.

While manipulating objects, you often need to view them at different zoom
levels.

To change the zoom level:

» On the ribbon, open the Zoom flyout toolbar and select an option:

Zoom by Rectangle

Figure 5-50: Zoom flyout toolbar
O Zoom Object focuses on the selected object.
3 Zoom Tray displays the whole tray.

O Zoom by Rectangle allows you to display a section of the tray by
selecting it with the mouse.

You can also zoom in and zoom out with the mouse wheel.

You can configure Objet Studio to automatically zoom in on the objects
placed on the build tray. See “Automatic Zoom” on page 53.
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Handling Completed Trays

After you have properly placed all objects on the build tray, you save the
tray as an objtf file, which is sent to the 3D printer for production. But before
saving the tray, you can check that there would be no problem producing it.
You can also calculate how much material would be consumed during
production and how much time this would take.

Tray Validation Before sending a job to the printer for production, you should check that
the tray is “valid” and can be printed.

To validate that the tray can be printed: Y
» On the Tray Settings ribbon, in the Build Process group, click valdate .
or—
From the Tools menu, select Placement Validation.

If the tray is not valid, the color of the problematic models on the tray
changes according to a pre-set code.

| @1
Constraints
Colars
Default Color
Outzide Tray
Callision

Bath

iin

Dynamic check
when to check

(® On Diop
(O \while Drag

Wwhat to check
Outside Tray
Object Collizion

Figure 5-51: Color code

Note: The “Both” color also indicates a problematic stl file.

The validation status appears on the bar at the bottom of the screen.

Yalidation succeeded Maodels: 1

Figure 5-52: Validation details in status bar

5-38 DOC-24333 Rev. A



Objet30 User Guide

Production
Estimates

E-mailing
Objet Digital
Files

Printing the
Tray File

DOC-24333 Rev. A

Objet Studio enables you to calculate the time and material resources
needed for producing trays before sending them to the printer. The time it
takes Objet Studio to perform this calculation depends on the number of
objects on the tray and their complexity. Calculating the production
estimate for a full tray could take up to 15 minutes, depending on your
computer’s specifications.

To calculate the time and materials needed for producing the current
tray: M

» On the Tray Settings ribbon, in the Build Process group, click estimate .

While the estimate is being calculated, a progress bar is displayed —on
the right side of the status bar (at the bottom of the screen).

I

I ks ____Cancel

Figure 5-53: Estimate progress bar

When Objet Studio finishes calculating the production resources, the
results are displayed in the Estimated Consumptions group on the Tray
Settings ribbon.

Yerohhite: 35.0
Suppork: 27,0
Building Time:  00:23
Estimated Consumptions
Figure 5-54: Production resource calculation
You can easily e-mail objdf files using Microsoft® Office Outlook®. Sending
objdf files is recommended (instead of st files) because the size of a file is

typically reduced by more than half. An added benefit is that the objdf file
contains the model-material information for the object.

To e-mail a file:
1. From the Tools menu, select Email Objet Digital File.

Outlook opens with the file attached and Subject details added to the
e-mail form.

2. Enter the e-mail address and send the file.

When a tray is ready to be printed, it is placed in the Jobs Queue. When the
job reaches the head of the queue, Objet Studio pre-processes the tray file to
create slices, and feeds them to the 3-D printer.

To send the tray to the print queue:
1. On the Tray Settings ribbon, Build Process group, click uid.
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If the build tray file has not been saved, the Save As dialog box opens for
you to save it now.

Objet Studio checks if there is a problem with the positioning of objects
on the tray. If so, the affected objects are displayed with special colors
(see “Tray Validation” on page 38), and a warning message appears.

Warning

Overlapping objects!
-- Click Mo to separate objects manually
or with Automatic Placement.

- Click ez to print the tray as is.

Do youl want bo proceed angway’?

Figure 5-55: Tray validation warning message

O To cancel the Build command so you can correct the problem, click
No.

O To print the models as they are positioned on the tray, click Yes.

The Job Manager screen opens, so you can monitor the progress of your
trays—before, during, and after printing. See “Monitoring and
Managing Print Jobs” on page 58.
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You can use the Split Object feature to produce objects larger than the tray
area by dividing the model into separate parts. With this feature, you
produce only a specific section of a model.

To split an object:

1.
2.
3.

Select the object.
From the Object menu, select Split.

In the Split Object dialog box, enter the values to determine how Objet
Studio will divide the object. You can divide an object along any of its
axes, by entering either exact measurements or the number of parts.

| Model Tree |
© Tray1 |
__| Applications - FLUTE_Shell3_Part1 |
_| Applications - FLUTE_Shell3_Partz

Obiject Size 35 226 225348

@splittpSice 97 |37 202 | [ Dateut
Ospitbytnter [ |[T [ ]

Figure 5-56: Split Object dialog box
In Save to Folder, enter the folder name.
Click OK.

The composite parts are saved as new st! files with “Part 1,” “Part 2,”
etc., added to the original file name.

Note: Before printing the newly created stl files, it is recommended that you

check them for defects in an STL-repair application, such as
Magics™, by Materialise®.
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When producing models, support material fills some hollow and empty
sections (see “Model Orientation” on page 5-21). Objet Studio allows you to
adjust the strength of the structure formed with the support material. This
adjustment is useful when producing either large/massive models or small/
delicate models. For most purposes, the default setting provides adequate
support strength.

To change the strength of the support structure used when printing a
model:

1. Select a model on the tray.
2. On the Model Settings ribbon, in the Options group, click %.
or—
¢  On the Model Toolbar, click .
or—
* From the right-click context menu, select Advanced Properties.

The Advanced Properties dialog box opens.

Advanced Properties ﬁ

Grid Style [ ] Hallaws
{*) Standard

) Heawy
(7 Lite

Apply

Figure 5-57: Advanced Properties dialog box

3. In the Grid Style section, choose the support strength suitable for the
selected model. You can select a different support strength for each
model on the tray.

* Standard —for models needing average support (most models).
* Heavy —for large models needing much support.

* Lite—for delicate models needing little support. (This setting makes
it easy to remove the support material.)

4. Click Apply.
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Many objects placed on the tray from st! files are “solid.” This means that,
when printed, the model will be completely filled with model material.
Often, especially with large objects, this is unnecessary. Instead, the model
can be filled with support material, which is less costly. It is also advisable
to fill models with support material when preparing them for investment
casting, since this material burns off more quickly during the process of
making the cast.

Objet Studio enables you to print objects on the tray with an outer shell of
model material and a center filled with support material. When using this
feature, called “Hollow,” the thickness of the shell should be no less than
0.5 millimeters.

To use the Hollow feature:
1. Select a model on the tray.
or—
¢  On the Model Toolbar, click o
or—
* From the right-click context menu, select Advanced Properties.
The Advanced Properties dialog box opens.
2. Select Hollow.

Advanced Properties

Grid Style Hollow

(%) Standard

O Heawy Shell Thickness: |1.35
O Lite

Apply

Figure 5-58: Advanced Properties dialog box

3. Set the shell thickness, in millimeters.

4. Click Apply.

Note: There is no change in the display of objects in Objet Studio when
Hollow is selected.

To inspect, change or cancel the Hollow setting:

1. Select a model on the tray.

2. Access the Advanced Properties dialog box, as above.

3. If you change or cancel the Hollow setting, click Apply.
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Displaying the  The Section feature enables you to view the interior of an object by “slicing”

Cross Section it on any axis. You can then manipulate the object to inspect the interior

of Objects from different angles. This may be important for deciding on the type of
support necessary when producing the model (see “Choosing the Support
Strength” on page 5-42). Displaying an object’s cross section only affects
how the tray is displayed on the screen; it does not change the object itself.

To display a cross section of the tray:
1. From the Tools menu, select Section.

The Section dialog box opens.

Section |X|

Section |

#

-

z

¥ Enable Clipping

Figure 5-59: Section dialog box

Select Enable Clipping.

3. Use the slider controls for the X-, Y-, and Z-axes to cut the tray so that
you see the cross section you want.

Figure 5-60: Whole view Figure 5-61: Cross-section view, after
using the Z-slider
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Saving the You can save the image displayed in the active viewing screen as a graphic
Screen Display file.
as an

To save the screen display as an image:
1. Press Ctrl+B.

or—

Image File

From the Objet Studio Commands Menu menu, select Save Bitmap.

The Save Bitmap dialog box opens.

Save Bitmap @
Savein | STL Fies | i i
=200 [0 To Last Folder Yisited]
(20148
*Apnllcatlons - Tab Coating.bmp
*Traya.bmp
File: name: ‘Applications - Tab Coating
Save as twper | Bitmap [ brp] Cancel
DataType: [RGB True Color  (24-bil) [=]
Compression: ‘ Mon-Compressed ﬂ

Figure 5-62: Save Bitmap dialog box

At the top of the dialog box, select the appropriate folder.

At the bottom of the dialog box, enter a file name.

Open the Save as type pull-down menu, and select the file format.
Click Save.

ISR
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When you save build trays in Objet Studio, they are saved as objtf files.
These files contain instructions to Objet Studio and to Objet printers for
displaying and producing the st! files used on the tray. To conveniently
save all of the files that comprise the build tray, for storing the job, or for
transferring it to another location, Objet Studio compresses them into one
objzf file. To later use the objzf file, the file must first be expanded in Objet
Studio and its component files saved.

Note: If you export an objzf file containing a stl file originally saved as read-
only, you cannot open (import) this objzf file to the folder where the
read-only stl file is saved.

To create an objzf file:

1. From the Objet Studio Commands Menu menu, select Export Packed
Job.

The Save As dialog box opens.

2. Select the appropriate folder and change the file name (if necessary).
3. Click Save.

To open an objzf file:
» Double-click on the objtf file.
or—

1. From the Objet Studio Commands Menu menu, select Import Packed
Job.

2. Inthe Open dialog box, display the appropriate folder and select the
file.

3. In the Browse for Folder dialog box, display the folder in which you
want Objet Studio to expand the compressed file, and click OK.

The objtf file and associated st! files are expanded and placed in the
selected folder, and the tray is displayed in Objet Studio.

Note: You can also export a print job as an objzf file from the Job Manager
screen—see “Exporting Jobs (objzf)” on page 70.
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Customizing Objet Studio

You can customize Objet Studio to suit your particular working needs and
preferences. Features that you can customize include:

* Creating a quick-access toolbar for frequently used commands.
* Changing the position of the Quick Access toolbar.

* Minimizing the ribbon.

* Changing the Objet Studio color theme.

* Configuring default settings for objects placed on the build tray.

Creating a As you work with Objet Studio, you may use certain commands frequently.
Quick Access You can create a quick-access toolbar to make your work easier.
Toolbar

To create a quick-access toolbar:
1. Above the ribbon tabs, click = .
The Customize Quick Access Toolbar menu opens.

Customize Quick Access Toolbar
Insert
Flacement:
Estimate
Build
Qpen...

More Commands. ..

Show Eelow the Ribbon

Minimize the Ribbon

Figure 5-63: Customize Quick Access Toolbar menu

2. Select a command you want to add to the toolbar.
An icon for the selected command is added to the toolbar.

e O

Tray Settings Job Mana

B e 3 S

Insert | Placement Yalidate Estimate Build

Model Build Process

Figure 5-64: Quick Access toolbar
To add another command, repeat the above procedure.
3. To choose from a wider range of commands:

* From the Customize Quick Access Toolbar menu (see figure 5-63 on
page 47), select More Commands.

or—

* Right-click on the Objet Studio Commands icon, or elsewhere on the
ribbon, and select Customize Quick Access Toobar.

Customize Quick Access Toolbar...

Show Quick, Access Toolbar Belaw the Ribbaon

Minimize the Ribbon

Figure 5-65: Right-click ribbon menu
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Hiding the
Ribbon
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5.
6.

The Options dialog box opens.

Options E]
Custamize ! Choose commands fram:
| kit il -
[Foputar Commands | B Job Manager |
Commands
<Separator
@ Automatic placement
@ Buid
EA Insert Model
> How | <
& Open
& Placement validation -~
B save |
[] Show Quick Access Toolbar below the Ribbon
Keyboard shortcuts:

Figure 5-66: Quick Access Toobar Options dialog box

Open the drop-down list and select either Popular Commands or
Commands not on the Ribbon.

Select a command and click Add.
Click OK.

To make more room for displaying the build tray, you can hide the Objet
Studio ribbons.

To hide the ribbons:

1.

Right-click anywhere on the ribbon or on the menu bar, or in the Objet
Studio Commands Menu () .

Select Minimize the Ribbon.

The ribbons disappear, but you can temporarily display the ribbon
icons by clicking Tray Settings or Job Manager on the menu bar. When
you next click outside of the ribbon, it disappears again.

To return the permanent ribbon display:
> Repeat the steps above to cancel Minimize the Ribbon.
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You can customize some of the colors used for displaying Objet Studio
screens and for displaying objects on the build tray.

To change the colors used in Objet Studio screens:
1. From the Tools menu, select Define Colors.
The Define Colors dialog box appears.

2. Inthe Define Colors dialog box, click the color patch you want to
change:

* Tray Color
* Background Colors

e Selection Color

Click the color patch you want to change,
and in the dialog box that opens,
zelect a color from the menu.

Tray Calor I:I
Background Colors I:I I:I
]

Selection Color

(%) Show Color According to Material
() Color According to Finish

[ Ok l [ Cancel ]

Figure 5-67: Define Colors dialog box

3. In the Color dialog box, select one of the Basic colors.

or—

Click Define Custom Colors to expand the dialog box and define a
customized color.

Basic colars:

B = e
HfTETHNN
ENNEENEEN
ENEEEENEN
EEEEEENN
EEEENE

Custom colors:

N T T Y I

Hue: Red:
mnininnin= celiia] com(25]
Define Custom Colors »> ColarSolid ) |y Blue:

[ 0] ] [ Cancel ] [ Add to Custom Colors ]

Figure 5-68: Color dialog box (expanded)
4. Click OK when done.

The patch color in the dialog box changes according to your selection.
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Changing Color Objet Studio offers a choice of four background color themes—blue, black,
Themes silver and aqua.

o T

D EVIE B B

Figure 5-69: Background color themes
To change the color theme:
* From the Style menu, select one of the options.

Keyboard You can define shortcut keys for frequently used commands.

Shortcuts To define shortcut keys:

1. Above the ribbon tabs, click = .
The Customize Quick Access Toolbar menu opens.
&

Customize Quick Access Toolbar

Insert
Flacement:
Estimate
Build
Qpen...

More Commands. ..

Show Eelow the Ribbon

Minimize the Ribbon

Figure 5-70: Customize Quick Access Toolbar menu
2. Select More Commands.

The Options dialog box opens (see figure 5-66 on page 48).
3. Click Customize.
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6.

The Customize Keyboard dialog box appears.

Customize Keyboard E‘
Categories: Commands:
~
Frint Preview Build Properties
Amrange Tray Default Properties.
Model Settings Exit
Job Manager Export PackedJob...
Import Packed Jab...
Job Manager...
I achine Properties w
Current Feys: Press new shortcut key
Home
Aszigned to:
[Unassigned)
Set Accelerator for:
¢ )
Description:
Build

Figure 5-71: Customize Keyboard dialog box

Select command Categories to display all the commands in that
category, for example, all the Model Settings commands.

Current shortcut keys are displayed.

Enter the shortcut key in the Press new shortcut key field, and click
Assign.

If you want to redefine all shortcut keys, click Reset All.

You can change several Objet Studio settings that affect objects placed on
the build tray.

To change default settings:

>

From the Objet Studio Commands Menu, select User Preferences.

User Preferences Pz|
Building Style Grid Style
(3) Matte (%) Standard
() sy (I Heawy
O Lite
Application Settings
[Lock Orientation
ot

Cancel

Figure 5-72: Setting work preferences

Building Style —see “Surface Finish” on page 17.
Grid Style—see “Using a Grid to Position Objects” on page 24.

Application Settings —see “Choosing the Support Strength” on page 42,
and “Freezing Model Orientation” on page 29.
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Professional Mode Features

Some advanced features of Objet Studio are only accessible in Professional
Mode.

To see the current Objet Studio setting:
» Open the Tools menu.

Tools =|style - (@) -

Grid
Snap ko Grid

Constrainks Setkings...

Section

Flane alignment 3

V' | Professional Mode

Language...
Options. ..

Define Colors, ..

Figure 5-73: Tools menu, showing Professional Mode selected
If Professional Mode is selected, advanced features are displayed.

To change the Professional Mode setting:
1. From the Tools menu, select Professional Mode.

The following message is displayed, reminding you that the change
will only take effect the next time you open Objet Studio—even though
the check mark next to the Professional Mode option appears
immediately.

L E The configuration changes vou have made will not take effect until the next time wou run the application,
L

Figure 5-74: Configuration-change message

2. Close and re-open Objet Studio to use the Professional Mode features.
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Default You can control the default settings of several Objet Studio features from
Settings the Advanced tab of the Options dialog box.

To display the Options dialog box

» From the Tools menu, select Options.

or—
In the Objet Studio Commands Menu, click Options.
Options g|
Appearance Grid M anipulate Dizplay
Settings Advanced Troublezhooting
[ suto Zoom

Orient Objects dutamatically

[ Ok H Cancel ]

Figure 5-75: Options dialog box, Advanced tab

Automatic By default, when Objet Studio places objects on the build tray, it orients
Orientation them optimally, for the shortest printing time. If necessary, you can choose
to cancel automatic orientation each time you place an object on the build
tray (see “Automatic Orientation” on page 18). In any case, when objects
are on the build tray, you can change their orientation manually, if
necessary —see “Model Orientation” on page 21.)

To change the default setting so that Automatic Orientation is disabled:
» In the Advanced section of the Options dialog box, clear the check box.

Automatic Zoom When Auto Zoom is selected in the Advanced section of the Options dialog
box, the display zooms to display the objects placed on the build tray. This
allows you to carefully inspect and manipulate the objects.

By default, this feature is not enabled. In any case, you can change the
zoom level, as necessary (see “Zoom Options” on page 37).
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Open GL The OpenGL driver displays 3D graphics on your screen. There is normally

Driver no reason to adjust its settings. If you suspect a problem with the way Objet

Configuration  Studio displays objects, you can use the OpenGL Driver Configuration tool
to check and configure the driver settings.

To access the OpenGL Driver Configuration dialog box:
1. From the Tools menu, select Options.
or—
In the Objet Studio Commands Menu, click Options.
2. Inthe Options dialog box, display the Troubleshooting tab.

Options g|
Appearance Grid Manipulate Dizplay
Settings Advanced Troubleshooting

OpenGL Driver Configuration. ..

[ (] 8 ][ Cancel ]

Figure 5-76: Access to GL-driver configuration

The Troubleshooting tab is only accessible when Professional Mode is
active (see Professional Mode Features).

3. Click OpenGL Driver Configuration.

The dialog box that opens displays details of the pixel format ID (index)
for the window and the memory.

X

OpenGL Driver Configuration

Window Pixel Format | Memony Pixel Format | Advanced

() Pixel Format D

(¥ Choose Format | Option 1 v
Color Bits 24
[epth Bits 32
Alpha Bits 0

[ Ok H Cancel ]

Figure 5-77: OpenGL Driver Configuration dialog box

If you want to display the values and change them, click L=d. Alternately,
you can select Choose Format and change the values in this dialog box.
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To perform a test of the driver configuration and enter the suggested
pixel format ID:

1.
2.

Select Choose Format.
Click Test.

Objet Studio returns the recommended pixel format ID.

Objet Studio X

.
\}4) Choose Pixel Format: 5

Figure 5-78: Recommended pixel format ID

Click OK.

In the OpenGL Driver Configuration dialog box (figure 5-77), select
Pixel Format ID and enter this number.

Click Apply.
Display the other pixel format tab, and repeat this procedure.
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Getting Additional Objet Studio Assistance

Objet Studio Help provides on-screen instructions and information, as you
work.

To view Objet Studio Help:

> On the standard toolbar, click ®' and then click Objet Studio Help.

Tools - Style - | @~

Objet Studio Help

Troubleshooting
Check for Updates

@) About...
Figure 5-79: Help options
You can also view information on the following subjects:

* Troubleshooting opens a list of error messages and their
explanations.

*  Check for Updates checks if you are using the latest Objet Studio
version.

Objet Studio Version, Material Module and Licensed Features

You can view details of the Objet Studio version, the material module
installed, and the features available with your license.
To view details of your Objet Studio installation:
» On the standard toolbar, click ®' and then click About....
Tools = Skyle - ._@.T

Objet Studio Help

Troubleshooting

Check for Updates
D)
Figure 5-80: Displaying Objet Studio details

About Objet Studio  The About Objet Studio tab shows the Objet Studio version number and
tab basic information about your computer.

(o) Ex

About Objet Studio | Materials Module | Feature License

(IBJET

Objet Studio Ver. 5.2

Copyright & 2013 Stratasys Ltd.
All rights reserved.

For Applications Support: applications-inkjet @stratasys.com

Operating System: Professional - (Build 5200}

Processor: Pentium [V+

Available Physical Memory: 2553 MB

System Resources: 28%
oK

Figure 5-81: About Objet Studio tab
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Materials Module The Materials Module tab shows details of the material module installed.
tab o s
Material: Module | Feature license

Module version:  9.2.30
Module Date: 28.06.2012

Module Properties: Default

Figure 5-82: Materials Module tab
e Module version

If a Materials Module upgrade (patch) was installed, the new Materials
Module version is displayed. If no patches were installed, the Module
version is the same as the Objet Studio version.

*  Module date

If a Materials Module upgrade (patch) was installed, the date of its
creation is displayed. If no patches were installed, the Module date is the
date of the Objet Studio version.

*  Module properties

If a Materials Module upgrade (patch) was installed, its description is
displayed. If no patches were installed, “Default” is displayed.

Feature License The Feature License tab shows the Objet Studio features available with your
tab license.

e] S|

| About Objet Studio | Materials Moduls | Feature License

(- Modes
[ Materials
[ Mixed trap

Figure 5-83: Feature License tab

Click [# to expand the details for each feature.
* Modes shows the printing modes available.

e Materials shows model materials available.
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Monitoring and Managing Print Jobs

W=

Job Manager

In the Job Manager screen of Objet Studio, you monitor and manage jobs
sent to the printer. There are a few differences between Objet Studio on
client workstations and on the computer connected directly to the 3D
printer —the server workstation.

* Objet Studio installed on a client computer only displays the queue and
status for jobs sent to the 3D printer server from that computer, and it
allows the user to edit only these jobs.

Note: If there are several Objet printers on the local network, client
computers can connect to any of them, but only one at a time.

* Objet Studio installed on the computer directly connected to a specific
3D printer (server), displays the queue and status for all jobs sent to that
3D printer by the server and by all client computers on the network. It
also allows editing and manipulation of all jobs, and enables re-sending
previously-printed jobs to the printer.

If Objet Studio is not connected to a printer (or printer server), you can
prepare tray files for any Objet printer. Later, these files can be used by
Objet Studio on the appropriate printer server.

The Job Manager screen on the client and server workstations looks

Screen identical. The only difference is that options only relevant to the server
workstation are disabled for client installations.
¥
Job Manager—{ = =
Ribbon
= e e
Jobs Queue—
T Available
Print Progress—{ | s —  resources
............................................................................. 1

5-58

Print History—

- e = Rdte | e .‘, ‘. Pt ki I' 4 ; Matenals
et [ consumption

Waste status

._.I ! ) f/ | Tray Preview

The Job Manager screen is divided into panels:

Figure 5-84: Job Manager screen

* Jobs Queue

* Printing Progress

* History

* Available Resources

* Material Consumption
* Tray Preview

¢ Waste
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Jobs Queue

Printing Progress
History
Available

Resources

Material
Consumption

Tray Preview

Waste
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On the server, the Jobs Queue lists the last 15 jobs sent from client
computers. On client workstations, the Jobs Queue lists jobs sent from that
computer to the printer server.

Information for each of the queued jobs is displayed, including the job
status.

Status Meaning

Waiting Printing of this job has not started.

Building Printing of this job is in progress.

Stopped Printing of this job was interrupted. Printing can later be

continued (Resume) or begun again (Restart).

Error Errors occurred during the printing of this job, and it was
placed in the Jobs Queue again.

Editing This job is now being edited in Objet Studio.

Spooling The job file is being spooled in the printer.

Preprocessing  The 3D printer is readying itself for printing: the cover
locks, print heads warm up and are put in starting
position, UV lamp is turned on, and the build tray level is
adjusted.

On Schedule The job is scheduled to be printed at a specified time.

In addition, the following information is displayed:
* Owner—the computer that sent the job.
* Build Time—the estimated building time for the job.

*  Model Consumption—the amount of model material required to
complete the job, and the amount actually used till now.

*  Support Consumption —the amount of support material required to
complete the job, and the amount actually used till now.

The Time panel shows printing times and the number of slices sent to the
printer.

The History panel shows information for the last 50 jobs and their final
status. You can drag a job from History to Jobs Queue to print the tray again.

The Available Resources panel contains graphic indicators that show the
amount of available printing material remaining.

* Actual—the amount of material used till now
* Required—the amount of material still needed to finish the job

The Tray Preview panel displays the build tray view of the job selected in the
Job Queue or the History list.

On a server, you can open an enlarged preview window by clicking on the
Tray Preview display (see “Extended Tray Preview” on page 68).

If you move the mouse over the Waste display, the amount of waste in the
container is displayed.

5-59



Using Objet Studio

Setting the When an Objet 3D printer is installed, the server computer is connected to
Printer that printer. Normally, there should be no reason to change this connection.
Connection Occasionally, however, you may need to reset the connection, to connect

the server to another printer, or to use Objet Studio in off-line mode
(without a printer connection).

To set (or change) the printer connection: )
1. On the Job Manager ribbon, in the 3D Printer group, click cenect,
2. Inthe Set Printer dialog box, click Connect.

Printer

=- Desktop

i - Objet30

Objet24

Objet30 Scholar

. . Objet30 Pro

i i.0Objet3D OrthoDesk
| -Eden 500V |
|| Eden 350¥ |
: Eden 260V

£- Connex

- Connex500

- Connex350
--Objet260 Connex
- Objets00 Connex3
-- Objet1 000

Ceomen.)

—

Figure 5-85: Connecting to a printer (A)

3. Enter the computer name or its IP address, or click Browse to find and
select it.

WM.B —
2 — [

Enter printer name/|P address.

Browse...

Usze ‘Unknown' for off-line mode.

Figure 5-86: Connecting to a printer (B)
4. Click OK.

When the connection is established, Objet Studio is configured to
prepare print jobs for that printer.

Objet Studio is connected to the printer if you can see the material levels in
the Job Manager screen (see figure 5-84 on page 57).
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Off-line Mode  You can use Objet Studio to prepare trays for printing in off-line mode, on
aremote computer or when the printer connection is not available. You also
use off-line mode to prepare trays for printing with other printers. In this
case, if Objet Studio is currently connected to a printer, you must change to
off-line mode by removing this connection.

To disconnect Objet Studio from the printer: @
1. On the Job Manager ribbon, in the 3D Printer group, click cenect,

2. Inthe Set Printer dialog box, click Connect (see figure 5-85).

Printer

=- Desktop

- Objet30

- Objet24

- Objet30 Scholar

- Objet30 Pro

- Objet30 OrthoDesk
- Eden 500V

 Eden 350V |
- Eden 260V

=- Connex

- Connex500

- Connex350

- 0bjet260 Connex
- 0bjethlld Connex3
- Objet1000

o ——.

(Gomert)

S —

Figure 5-87: Disconnecting Objet Studio from a printer (A)

3. In the Printer Connection dialog box, delete the computer name/IP
address.

2 — [

Enter printer name/|P address.

Browse...

Usze ‘Unknown' for off-line mode.

Figure 5-88: Disconnecting Objet Studio from a printer (B)

4. Click OK.
“Unknown” appears in the printer-name field.
5. Click OK.
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6. Inthe pop-up message, confirm that you want to work in off-line mode
by clicking No.

M Job Manager

i ) Ohijet Studio is in off-line mode.

Do wou wankt bo connect ko a 30 prinker?

Figure 5-89: Off-line message
When Objet Studio is in off-line mode, you can configure it for preparing
print jobs for different printers.
To change the Objet Studio off-line configuration:
1. In the Set Printer dialog box, select a printer type.

Printer

- Desktop

. . Objet3D

- Objet24

-- Objet30 Scholar

-- Objet30 Pro

-- Objet30 OrthoDesk

: e —Y
Cox D
. . Eden 500V —— |
. -Eden 350 |
i i-Eden 260¥
- Connex

- Connexb00

- Connex350

Objet260 Connex
Objets00 Connex3
Objet1 000

Figure 5-90: Off-line printer selection
2. Click OK (not “Connect”).
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When you open Objet Studio for the first time in a client installation, you
are prompted to connect to an Objet server computer that sends jobs to a 3D
printer. To do this, the server computer must be operating and connected to
the local network.

To set (or change) the connection to the server-computer:

1. On the Job Manager ribbon, in the 3D Printer group, click

Connect*

2. Enter the name of the server computer or its IP address, or click
Browse to find and select it.

3. Click OK.

rFi
,j--._; < _._/“_)L -

Specify Server Computer name/|F address.

Browse...

Usze ‘Unknown' for off-line mode.

Figure 5-91: Printer Server Connection dialog box
The Job Manager ribbon has three icon groups:
¢ 3D Printer

* Queue
e Job

® o Faldd e

Connect Motifications Top

Ok ¥EL
Up  Down Bokbomn | Restart Stop Resume Delete Wiew  Edit
30 Printer Queue Job

Figure 5-92: Job Manager ribbon commands

Icons are enabled or disabled according to their relevancy. For example,
you cannot stop printing a job that is not being printed, so the Stop
command is disabled.
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The following operations are available on the Job Manager ribbon:

Group Icon Purpose
3D [_';5 Client: Sets the server connection. See “Setting the Remote
Printer ", Printer Connection (Client Mode)” on page 63.
Server: Sets the printer connection. See “Setting the Printer
Connection” on page 60.
.. Configures options for printer alerts. See “Configuring User
nications AleTts” on page 66.
Queue Iﬂ Server: Moves a job to the head of the Jobs Queue.
Top Client: Disabled.
See “Jobs Queue” on page 59.
\A Server: Moves a job to a higher position in the Jobs Queue.
Up Client: Disabled.
See “Jobs Queue” on page 59.
\ﬂ Server: Moves a job to the bottom of the Jobs Queue.
gottom Client: Disabled.
See “Jobs Queue” on page 59.
Iﬂ Server: Moves a job to a lower position in the Jobs Queue.
G Client: Disabled.
See “Jobs Queue” on page 59.
Job {_!‘, Server:

Restark

* For ajob in the Jobs Quene—Prints it again (from the
beginning).

* For ajob in the History list—Moves it to the Jobs Queue
for printing.

Client: Disabled.

See “Restarting Jobs” on page 69.

Server: Stops a job in progress.
Client: Disabled.

Skop

@; Server: Continues printing the current job from the point
. where printing stopped.

esme

Client: Disabled.
See “Resuming Jobs” on page 69.

Removes the selected job from the queue.

Drelike:

2%  Refreshes the image of the selected job in the Tray Preview
= display.

Vigw

_.#  Opens the ngl Settings screen and displays the tray. For

%= deleted jobs, this enables you to make changes before

Edit printing.
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In addition to using ribbon command icons, you can use commands on
context (pop-up) toolbars and from the Job menu on the standard toolbar.

Restart

. Delete

—— Resume

Stop / !:, Ei
» Y

Edit v B b\—

Export -

packed job

Schedule

Figure 5-93: Icons on pop-up toolbar (server)

Edit ——— .

Delete

Figure 5-94: Icons on pop-up toolbar (client workstation)

Note: Most icons and menu commands are only enabled when a job is selected.

When you position the cursor over an item,
the command.

Job = Tools = Skwle -

% sStop...

*. Delete Job...

Show 3dProgress

. Export ...

Figure 5-95: Job menu options (server)

a tooltip displays the name of
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Objet Studio can alert you (and others) to the status of jobs sent to the server
for printing. This is especially useful during long printing jobs, when the
operator is away from the printer. The following events can be reported:

* The level of model or support material is low.
* The job was interrupted.
* The job was completed successfully.

To send e-mail and SMS alerts, make sure that e-mail software supporting
MAPI is installed on the server computer. To send SMS alerts, the cellular
phone service must support the transmission of e-mail messages by SMS.

Only the subject line of the e-mail message is transmitted by SMS.

To configure Objet Studio to send notifications and alerts:

et
1. On the Job Manager ribbon, in the 3D Printer group, click Hetfieations

Notifications El
Sound Alert
@ (5) Woice Messages (3 PC Speaker
7

Fieport to Printer

HP Desklst 3300/9320/9350 [ Pines. |
Fiepart to e-mail
dd Recipient

Remove Recipient

Add Recipient

[] Riepot via SMS

Q RemindMe 15min | Before Cartridges Emply

Q RemindMe 100g | Befors Cartridges Empty
oK. Cancel

Figure 5-96: Notifications dialog box (server)

Notifications @

Sound Alert
@ @) Voice Messages ) PE Speaker
28

[ Report to printer

Fieport to e-mail
#dd Recipient
Remove Recipint

[ Report via SMS

Figure 5-97: Notifications dialog box (client workstation)

2. Set the desired reporting options.
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3. Click Details.

4.
5.

X

Select Events to repart on;
Sucoessful job finish
Job interruption

End of kMaterial rerminder

I Ok ] [ Cancel ]

Figure 5-98: Event selection for alerts

In the Reports Events dialog box, select the alert events and click OK.
In the Notifications dialog box, click OK.

If there is a job in the Jobs Queue, it is sent automatically to the Objet
printer—as long as it is on, there is a connection to the printer, and the
printer is on line. Chapter 6 describes starting and operating the printer.

Objet Studio on the printer server includes the following additional
features:

Extended Tray Preview

Editing Jobs

Restarting Jobs

Resuming Jobs

Scheduling Jobs

Exporting Jobs (objzf)

Modifying the Job Manager Screen

These features are described on the following pages.
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Extended Tray Preview

In this window, you can view the tray from different angles and
magnifications without leaving the Job Manager screen. In addition to
displaying the selected job in the Tray Preview pane, you can open an
enlarged build tray window.

To display the build tray window:
1. Select a job in the Jobs Queue or the History list.
2. Click the Tray Preview pane.

VHYIYEOE @D

Figure 5-99: Job Preview

* To change the tray magnification, turn the mouse wheel.

* To view the tray from a different perspective, click the relevant icon.
* To resize the window, drag its edge or corners.

If there are several objects on the build tray, you can exclude one or more
from being printed, without actually deleting the object from the tray file.

To prevent the printing of an object on the build tray:
1. Double-click on the object you don’t want to print.
2. Display the Build tab.

3. Select Exclude from Build.

2-0148.5tl

| Info | Options | Build

Exclude from Build

0Objet Studio

Figure 5-100: Excluding a model from the build

4. Click Yes to confirm.

On server computers, you can use Tray Preview to dynamically display
objects as they are printed, layer by layer. This enables you to visually
monitor printing progress on the computer screen.
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To display printing progress in the Tray Preview pane:
» From the Job menu, select Show 3dProgress.

This option uses additional system resources.

Editing Jobs

You can open jobs in the Jobs Queue for editing.

To edit a job:

1. Select the job. -

2. Click the Edit icon o .
The Tray Settings screen opens, displaying the build tray. The status of
the job in the Job Manager screen changes to “Editing.”

3. Edit the job. s
On the Tray Settings ribbon, click e -
The status of the job in the Job Manager screen changes back to
“Waiting.”
Restarting Jobs
You can restart jobs from the Jobs Queue and the History list.
To restart a job:
1. Select the job. :
e
2. Click the Restart icon restart .
The job status changes to “Waiting” (in the Jobs Queue).

Resuming Jobs

If the printing process is stopped or interrupted, you may be able to
continue printing the job from the point where printing stopped.

To resume a job:
1. Select the job. _
2. Click the Resume icon esme.
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Scheduling Jobs

You can schedule jobs to be printed at a future time. For example, you can
configure Objet Studio to start long printing jobs in the late evening and
early morning hours.

To schedule a job:
1. Select ajob in the Jobs Queue, and click € on the pop-up toolbar.
2. Inthe Scheduler dialog box, set the Start Date and Start Time for the job.

Click on the Start Date arrow to open a calendar.
f X

Iv Start Printing job in schedule:

Start Date: Sunday  11/04410 -
B apiizonn 3

Sun Mon Tue Wed Thu Fri Sat |-
T2 3|

4 5 B 7 & 9 10

[ 12 13 14 15 16 17
18 19 20 21 22 23 24

28026 27 28 29 ;W J

—2 Today: 4/11/2010

Figure 5-101: Scheduler with calendar displayed
3. Click OK.

Exporting Jobs (objzf)

You can save print jobs as compressed files.

For an explanation of objzf files, see “Exporting and Importing Objet Build
Trays” on page 46.

To export a print job:

1. Select a job.

2. On the pop-up toolbar, click &

3. In the Save As dialog box, selg a folder.
4. Click Save.

Moditying the Job Manager Screen

You can change the size of the sections of the Job Manager screen, by
dragging the panel edges. This applies to:

* the Jobs Queue panel
* the Time panel
* the History panel

Similarly, you can change the way the screen area is divided between the
main section (Jobs Queue/Time/History) and the panels on the right side of
the screen.

You can collapse (hide) the right panels (Available Resources/Material
Consumption/Tray View) by clicking the top of the panel.

* C(lick again to display the panel.
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Operating & Maintaining the
Objet30 3D Printer

Starting the Objet30 Printer ..., 2
Loading Model and Support Cartridges.........cccccevriiiiicncnnnes 4
Producing Models ..o 6
Printer Interface Color Key ........cccoviiiiiiiincccicccccces 8
Printing INdicators ... 9
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Operating & Maintaining the Objet30 3D Printer

Printer cover

Printing-materials &
waste compartment

Printer stand

Figure 6-1: The Objet30 3D Printer

Starting the Objet30 Printer

& CAUTION!

* Do not attempt to operate the Obijet printer before being trained by a
Stratasys customer-support representative.

* Observe all safety warnings and follow the safety guidelines described
in chapter 2.

1. Turn on the main power switch, located at the back of the printer.

Figure 6-2: Main power cable and switch

The main power switch turns on the Objet printer, which includes the
built-in computer.
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Printer mode

Online/offline button

Stop button

Support material
cartridges

2. After the computer boots, log in to Windows and launch the printer-
control application:

* On the computer desktop, double-click the Objet printer icon.

or—

* From the Start menu, select Objet > [Objet30 printer].
A HASP plug containing a valid product activation key is required on the
printer computer. This is installed at the factory or during printer upgrade. If

the application does not open and a HASP message appears, contact your
dealer or Stratasys Customer Support.

The Objet printer interface screen opens (see figure 6-3). All monitoring
and controlling of the printer is done from this interface.

File_Options_Help _x |

" Ystratasys

Current activity

Display
toggle button

Pause button

| @BJET ¢ Verownte - FulCureTos

=

DOC-24333 Rev. A

280 gr ‘
FullCure705 L __J
e 620 gr .
R=cieue) Model material
cartridges

Figure 6-3: Objet30 interface

Objet installations use one monitor for displaying both the computer running
Objet Studio and the computer installed inside the printer. Make sure that
the KVM (keyboard-video-mouse) switch is in the correct position so that
the printer interface is displayed.
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Loading Model and Support Cartridges

6-4

=

Objet30 printers use two cartridges of model material and two cartridges of
support material, each weighing one kilogram when full. A graphical
representation of the cartridges loaded and their current weight appears in
the printer interface (see figure 6-3).

Note: The printer-control interface displays the type and weight of the
material cartridges loaded only if the printing-materials drawer is
closed.

The printer uses RFID technology to automatically identify cartridges of
printing material. For this purpose, an RFID module is part of the printer
hardware. Tampering with this module will render the printer inoperable and
may void Stratasys warranties and service contracts.

Important: If you need to replace the model material currently
installed with another type, see “Changing the Model Material”
on page 6-12. Otherwise, make sure to replace the model
cartridge with one containing the same type of material.

To load model and support cartridges:

1. On the front of the printer (see figure 6-1), push the printing-materials
drawer to release it and pull it open.

2. If you are replacing a cartridge, remove the old one by pulling it
straight up.

3. Load model and support cartridges into their respective compartments
(see figure 6-4).

Support 2

Figure 6-4: Printing-materials drawer

You should feel some resistance, as a needle pierces the cartridge.

4. Close the printing-materials drawer.
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5. Check the printer interface to make sure that the new cartridge is

detected and that its weight is displayed (see figure 6-3).

Tips about replacing cartridges:

You can replace material cartridges either before or during printing. If
you do so while printing, make sure to load the new cartridge and close
the cartridge drawer within three minutes. This ensures that the print job
is not interrupted. (When the drawer is open, the cartridges are not
displayed in the printer interface.)

If printing stops for an extended time before you replace a material
cartridge, the printer may go into Standby or Idle mode. If this happens,
see “Resuming Production After Printing has Stopped” on page 10.

You can replace partially used cartridges to avoid the need for replacing
them during printing. However, repeated removal and installation of a
cartridge may cause the material in it to leak. Therefore, it is
recommended that you limit the re-installation of used cartridges.

You can load partially used cartridges, as long as they contain more
than 100 grams of material.
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Producing Models

The Objet30 printer produces models by printing tray files prepared in the
Objet Studio application and sent to the printer from there. For information
about preparing model files for printing, see “Using Objet Studio” or Objet
Studio Help.

The Objet30 printer is capable of printing models with the following
maximum dimensions:

N

With glossy finish—

X-axis: 294.00 mm (11.57 inches)
Y-axis: 192.00 mm (7.55 inches)
Z-axis: 148.60 mm (5.85 inches)
With matte finish—

X-axis: 293.00 mm (11.53 inches)
Y-axis: 191.00 mm (7.52 inches)
Z-axis: 148.30 mm (5.83 inches)

Before beginning to produce models, it is recommended that you check the
current printing quality of the print heads by performing a pattern test (see
“Pattern Test” on page 25).

To prepare the printer for producing models:

1.

Make sure that the build tray in the printer is empty and clean. If not,
remove cured material with the scraper, and clean the tray thoroughly
with cleaning fluid.

CAUTION: Use protective gloves when cleaning the build tray, and be
careful of the sharp edges of the scraper blade.

2.

Make sure that there is sufficient model and support material loaded,
as indicated in the printer interface (see figure 6-3). You may want to
replace the cartridges of model and support material currently loaded
in the printer to avoid the need for replacing them during printing.

For installing material cartridges and replacing empty ones, see
“Loading Model and Support Cartridges” on page 6-4.

At the bottom of the printer interface, click the red button to switch the
printer to online mode.

The color of the button changes from red to green (see figure 6-7). If
there is a job in the Job Manager queue, it is sent to the printer.

DOC-24333 Rev. A



Objet30 User Guide

DOC-24333 Rev. A

In the printer interface, the printer mode changes from Idle to Pre-print, as
the printer’s components prepare themselves for production:

* The print block is heated.

* If more than 48 hours have passed since the last print job, the printing
materials in the print heads are flushed and replaced, to ensure quality
printing. (This step adds 7 to 14 minutes to the Pre-print cycle, and it is
displayed in the printer interface.)

Figure 6-5: Relnitiate process during the Pre-Print cycle

* The UV lamp is powered and it warms up.

When printing begins, Objet Studio sends seven slices to the printer. This is
the standard buffer between Objet Studio and the printer. As each slice is
printed, another slice is sent to the printer.

Depending on the size of the model(s) to be produced, printing can take
between several hours to several days. As long as there is enough model
and support material in the supply cartridges, printing proceeds
automatically until the job is finished.

During printing, the server computer must remain on and it must
communicate with the Objet printer. Do not log-off Windows until printing is
finished.

The Objet printer uses one model-material cartridge and one support-
material cartridge to produce models. When four cartridges are loaded in
the printer, two of them are reserve, or standby, cartridges. By default, the
printer first uses the cartridges with the least material in them.

» The active cartridges are blue in the printer interface.

When the weight of a cartridge drops below 100 grams, the remaining
material displayed in the printer interface is red. The printer then alternates
the pumping of material between the heavier and the almost-empty
cartridge. This is indicated in the printer interface by an hour-glass icon.
(See figure 6-8 on page 9.)

When a cartridge is completely empty, a trash icon is displayed.

_ VeroWhite _

3

Figure 6-6: Empty cartridge indicator

You can monitor printer status indicators by switching the printer interface
display. To do this, click the display toggle button in the printer interface
screen.
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Block temp.
~ behind

model head

Block temp.
in front of
print heads

Printer set to
online mode

Printer
Interface
Color Key

@

(green) “

File_Options_Help _ x|
System

ec : vacuum level
Heads(°C) — Sensors B

| - i
Maintenance Suppnrt Waste(gr) m UV Lamp
Model 5 Ambient (°C) E|

Heads Liquid [T

- Vstratasys

material in print-
block reservoir

Verowhite FullCure705

| |
‘ Display
toggle button

! T ‘
FullCure705 d Active material
cartridges (blue)

Reserve material
cartridges (gray)

Figure 6-7: Printer indicators
The background colors in the printer indicator fields tell you at a glance
whether or not the value or item is suitable or ready for printing.
* Green—suitable/ready for printing
For example, in figure 6-7:

O Ambient—The ambient temperature of the printing chamber is
within the acceptable range.

0O Heads Liquid—The level of model and support material in the print-
block reservoir is OK.

O Vacuum—The vacuum level in the system is within the acceptable
range.

* Red—not suitable for printing (or indicates a warning)
For example, in figure 6-7:

O Waste—The weight of the waste container is 1520 grams, more than
allowed when beginning a print job. (See “Replacing the Waste
Container” on page 6-44.)

* Blue—not ready
For example, in figure 6-7:
O UV lamp—The UV lamp is not on.

O Heads (°C)—The heads have not reached the temperature required
for printing models (in printing mode).

The color of the material cartridges displayed in the printer interface
indicates which cartridges are active for the current (or next) print job.

* Blue—active cartridges

* Gray—reserve cartridges

DOC-24333 Rev. A



Objet30 User Guide

Printing The printer interface screen changes when you send a print job from Objet
Indicators Studio to the printer, and the printer is on line (see figure 6-8):

* The mode changes from Pre-print to Printing.

* The specific activity being performed is shown in the “current activity”
field.

* Current job-printing information is displayed.
* The printing progress bar is displayed.
* The Stop and Pause buttons are enabled.

N

File_Optians _Help _x
20 Dec 2012 11:36

' Vstratasys

Progress bar

FullCure705

280ar

FullCure705 | N—
e 620 gr

el Distributed

pumping

Almost empty

Figure 6-8: Printer interface during printing
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Resuming Production After Printing has Stopped

If the printing process is interrupted, Objet Studio stops sending slices to
the printer. This can happen, for example, if the printing material runs out
in the middle of a print job, and you don't replace the empty cartridge
immediately. After the printer changes to Standby or Idle mode, you need to
resume printing from the Job Manager screen of Objet Studio.

print heads is reduced. About 20 minutes later, the printer goes into Idle

% After printing stops, the printer goes into Standby mode, when heating of
mode, when heating of print heads is stopped.

To continue printing the model:

1. If the printer is in offline mode, switch it to online mode by clicking the
red button at the bottom of the printer interface (see figure 6-3 on
page 3).

The button changes from red to green (see figure 6-7 on page 8).

2. If you don’t know why printing has stopped, make sure that the
connection between the printer and the server computer is active.

3. In the Job Manager screen of Objet Studio, click the Resume icon e

Resume *

4. In the Continue from Slice dialog box that appears, confirm the slice
number, after checking the printer interface.

File Options Help _ X |
20 Dec 2012 11:36

& Stratasys

Printer mode

Last slice
[ printed

Figure 6-9: Printer interface after interrupted printing

Continue from Slice:

278

ook | l Cancel ]

Figure 6-10: Continue from Slice confirmation in Objet Studio (Job Manager
screen)

5. If, for any reason, the correct number does not appear in the dialog
box, enter the number and click OK.
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You cannot continue printing the model if:

* The number of the last slice printed does not appear in the printer
interface, even if the server computer displays the Continue from Slice
confirmation dialog box.

* There was a relatively long interruption in printing, even if the “last
slice” and “continue from slice” indicators are correct. The part of the
model already printed may deform or shrink, and there might be a
visible difference between it and the newly printed part. The effects of a
printing stoppage on a model depend on the model size and structure,
model material used, ambient temperature and the length of the
stoppage.

If you cannot continue printing:

1. Cancel the print job in the Job Manager screen.

2. Remove the partially printed model from the build tray.

3. Restart the job from the Job Manager screen (in Objet Studio).

from the Job Manager screen of Objet Studio, since both applications are
updated when you use these commands. However, after clicking the Pause
button in the printer interface, you can only resume printing from the printer
interface.

%( You can stop and later resume printing from either the printer interface or
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Changing the Model Material

Before producing models using a different type of model material than is
currently installed, run the Material Replacement Wizard to flush the print
block and feed tubes.

avoid unnecessary waste of the materials currently loaded. The amount of
material flushed depends on the flushing cycle chosen and if you are
replacing one or both materials. For details, see page 13.

% You should carefully plan printing models with different model materials to

To replace the model material:
1. Start the Material Replacement Wizard from the Options menu.

-
File Options Help =l |
Go to Tray Upper Positon F5
Goto Service Position F&
Wipe F7

Pattern Test F3

. e e—

Heads Cleaning

Maintes Counters...
an nanc? oumers Material Replacement ‘I
Collect Service Data F2

UV Lamp Replacement |

| Vstratasys

Shutdown Wizard F8 Wiper Cleaning
Head Replacement
| - Load Cell Calibration
Relnitiate

Material FlushFill Wizard

22220r

Support Resin ==

Model Resin

T Trmror

o — —

Figure 6-11: Starting the Material Replacement Wizard from the Options menu
In the opening screen, click Next.

3. If the printer cover is not closed, a screen appears instructing you to
close the cover. Confirm that it is closed and click Next.

4. In the Compartment Selection screen, select the cartridge(s) you want to
replace, and click Next.

Material Replacement Wizard le

Compartment Selection

M1 r
52
51 .
[ M1 compartment
[ M2 compartment
[ More...
< =

Figure 6-12: Compartment Selection screen
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5. From the drop-down menu, choose the material you want to install,
and click Next.

Material Replacement Wizard

Material Selection

Select material type for Model compartment:

[
WeroBlack

Werchwhite

©OBJET

XK Cancel | & Previous | Mext = |

Figure 6-13: Material Selection screen

Note: This selection automatically affects the default material setting in
Objet Studio.

The Model materials available for selection depend on your printer type or
license.

6. In the Flushing Options screen, choose the appropriate cycle for the
model material you want to install.

Material Replacement Wizard fgl

Flushing Options

Selectthe flushing cycle required:

() Economy [approx. 25 minutes)

(®) High-performance [appros. B0 minutes)

’ X Qancel] ’{Erevious” Mext g ]

Figure 6-14: Flushing Options screen

Economy. During this cycle, which takes about 25 minutes, the
pump purges the model material from the print block, then flushes
the system with the new material.

Since traces of the previous material may be present in the first
models printed with the new material, this cycle is usually
acceptable when replacing a light-colored model material with a
darker material (such as VeroBlack™), or if the exact color of the
printed models is unimportant. However, this cycle ensures that
models will have the mechanical properties of the new material.

The amount of material flushed during this cycle is—
xt 65 grams (+ 10%) when replacing one cartridge

x 110 grams (+ 10%) when replacing two cartridges
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* High-performance. During this cycle, which takes about 60 minutes,
the wizard cleans the feed tubes and print block more thoroughly
by flushing the system with more material.

This cycle ensures that models will have the color (and the
mechanical properties) of the new material, when replacing a dark-
colored material (such as VeroBlack) with a lighter-colored material.

The amount of material flushed during this cycle is—
x 300 grams (+ 10%) when replacing one cartridge
xt 450 grams (+ 10%) when replacing two cartridges

7. Click Next, and take note of the warning screen.

Material Replacement Wizard fg\

Please Note:

Beyand this point, clicking Cancel will abortthe wizard
and disahle printing.

Printing will be enabled only after completion of this
wizard

OsJeT

[ x LCancel ] [-(Erewousl | LERE o |

Figure 6-15: Material Replacement warning screen

models with the Objet printer. To perform the procedure at another time,
click Cancel. If you continue (by clicking Next) and you do not complete the
procedure, you must start the Material Replacement Wizard again before
producing models.

% Once you start this procedure, you must complete it before you can produce

8. To continue, click Next.

9. When prompted by the wizard screen, remove the material cartridge.
Confirm and click Next.

Material Replacement Wizard

Remove Cartridge

Confirm before continuing:

[ Cartridge removed from 1 compartment.

—_—
.

x Lancel | ~( Previous |

Figure 6-16: Remove Cartridge confirmation screen
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10. When prompted, load the new cartridge(s) and close the drawer.
Confirm this in the wizard screen and click Next.
After identifying the cartridge(s), the printer begins filling the print
heads with the new model material.

Material Replacement Wizard

Material Replacement in Progress

aﬁ This process will take approximately B0 minutes.

-

OBJET

Figure 6-17: Material replacement: filling heads with new material
11. When the final wizard screen appears, make sure that the screen
displays the newly-loaded material(s). Click Done to close the wizard.

12. Clean the area around the purge unit.

& CAUTION: Dispose of all material cartridges in accordance with all
applicable laws and regulations. If necessary, the cartridges can be
disassembled for recycling. If this is done, protect the person handling
the cartridges from direct exposure to uncured resins.

The printer-control application is automatically updated, and the interface
should display the new material(s). The Objet Studio application (on the
printer-server workstation) is also updated.
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Keeping the Printer in Idle Mode

6-16

S

Between printing jobs, the Objet30 printer can be kept on for up to one
week. If the printer will not be used for more than a week, use the
Shutdown Wizard to automatically perform the procedures that must be
done before turning off the printer (see “Shutting Down the Printer,”
below).

When the printer stops producing models, the printer software
automatically reduces the temperature of the print heads as follows:

Time after printing Mode Change in heating of print heads
first 15 minutes Standby 1 none

next5 minutes Standby 2 heating reduced (to room temp.)
after 20 minutes Idle heating stopped

Note: The printer mode is indicated in the green field on the left of the
interface (see figures 6-3, 6-7 and 6-8 on pages 3, 8 and 9).

If, after printing a job, you know that the printer will not be used for 20
minutes or more, you can immediately turn off the heating of the print
heads by putting the printer into Idle mode.

To put the printer into Idle mode:

» From the File menu (in the printer interface) click Exit.

Note: The printer remains in Idle mode until you open the Objet printer
application and begin printing again.

When the printer is in Idle mode, do not turn it off. It can remain in this
mode—uwith the cover closed—for up to a week. For longer periods, shut
down the printer by running the Shutdown Wizard (see below).
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Shutting Down the Printer

You only need to shut down the Objet printer if it will not be used for a
week or more. Otherwise, the printer can remain on, in Idle mode.

W=

Shutdown
Wizard

DOC-24333 Rev. A

The Shutdown process flushes printing materials from printer components.
To avoid flushing out valuable material, make sure to print models at least
once a week. Many printer operators use this opportunity to print customer
samples or test models.

To properly shut down, the printer needs to perform several processes. Do
not attempt to shut down the printer by simply closing the computer
interface (the printer-control application), and never disconnect power to
the printer before completing the Shutdown Wizard.

Shutdown for Less Than One Week

Before shutting down the printer or the printer computer for less than
one week, run the Shutdown Wizard. This wizard clears the print heads
of printing materials before shutdown.

Shutdown for One Week or More

Before shutting down the printer or the printer computer for one week
or more, first run the Material Flush/Fill Wizard. This wizard replaces
printing materials in the print block with cleaning fluid. Then, run the
Shutdown Wizard to complete the shutdown process.

Note: After preparing the printer with the Material Flush/Fill Wizard, you

must run it again before printing models, this time to replace the cleaning
fluid in the print block with printing materials.)

To run the Shutdown Wizard:

1.

Select Shutdown Wizard from the Options menu, or press F8.

Shutdown wizard g]
Z= Shutdown wizard
i
\
| I= A = This wizard will prepare the machine for shutdown.
\-@\ Fress [Mext] to continue or [Cancel] to quit.
(%) Run wizard marually.
A () Run wizard unattended.
— MW

Figure 6-18: Shutdown Wizard, opening dialog box

In the opening wizard screen, click Next.

Note: Run wizard manually is selected by default. It is recommended that
you do not change this selection, to have more control over the shutdown
process. If you select Run wizard unattended, the shutdown process may
take longer, and the wizard will automatically shut down the printer
computer.
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3.

In the next screen, indicate whether or not the tray is empty and click

Next.

r =

Shutdown wizard @

l; //—\\ | Shutdown wizard

Flease verify thatthe tray is empty.

w " Tray is empty
{* Tray i full [choosing this option will move trap down)

x Cancel | % | ﬂaxt) |

Figure 6-19: Tray status screen

The shutdown procedure begins.

Shutdown wizard \

L. Shutdown Sequence

&

Shut Down Clearing heads..

i

x Cancel | % | |

Figure 6-20: Shutdown progress screen

The shutdown procedure may take up to 10 minutes while the

following tasks are performed:

a. The print block returns to its starting point on all axes.

b. The print heads are heated.

c. The print heads are cleared of any remaining material.

After these tasks are completed, the final wizard dialog box appears, in
which you choose whether or not to shut down the computer in the

Objet printer at this time.

@ =

Shutdown wizard rg‘
E Computer Shutdown
=

Do you wantto shutdown the computer?

[+ ‘Yes

" Mo

Niwod | < i

Figure 6-21: Computer Shutdown confirmation dialog box
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Material
Flush/Fill
Wizard
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When completely shutting down the Objet printer and turning the
power off, select Yes and click Next.

After the printer computer shuts down, turn off the main power switch
at the back of the printer (see figure 6-2 on page 2).

You use this wizard to prepare the printer for a shutdown of more than one
week, and to restore the printer to working condition.

To prepare the printer for an extended shutdown, the wizard drains
printing materials from the print heads, then flushes the system with
cleaning fluid. This process takes about 60 minutes.

For this procedure, you need to load four (4) cleaning-fluid cartridges in
the cartridge drawer.

To restore the printer to working condition, the wizard fills the system
with printing materials. This process takes about 30 minutes.

For this procedure, you need to load two (2) cartridges of model
material and two (2) cartridges of support material.

To run the Material Flush/Fill Wizard:

1.
2.

Select Material Flush/Fill Wizard from the Options menu.

In the opening screen, click Next.

]

Material Flush/Fill Wizard

Procedure Selection

* Drain materials & flush spstem with cleaning fuid.

" Fill systermn with printing materials.

——
.

X Concel | € Brevious | [

Figure 6-22: Wizard procedure selection

3. Select the required procedure, and click Next.

Note: Before continuing, make sure the required cartridges of material are
available for the procedure selected.
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4. Load the required cartridges, close the cartridge drawer, and confirm
this in the wizard screen.

Material Flush/Fill Wizard le

Prepare the printer

Confirm before continuing:

[] 4 cleaning cartridges are loaded.
[ Each cartridge with minimum of 300 gr.
[ The drawer is clozed.

’ XK Cancel ] ’{Erevious] T

Figure 6-23: Cartridge confirmation screen—before shutdown
Material Flush/Fill Wizard rz|

Prepare the printer

Confirm before continuing:

[ 2 'model' of the same material + 2 'support’ cartridges
[ Each cartridge with minimum of 240 gr.
[ The drawer is clozed.

-
-

’ XK Cancel ] ’{Erevious] T

Figure 6-24: Cartridge confirmation screen—before printing

5. In the next wizard screen, confirm that the printer cover is closed, and
click Next.

The wizard runs the material-flushing cycles.

X

Material Flush/Fill Wizard

Emptying block... {Cycle 1 of 25)

-
-

XK Cancel | <2 | s |

Figure 6-25: Flushing cycles in progress
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6. If cleaning-fluid cartridges are loaded in the printer, the wizard
prompts you to remove them. Confirm this in the wizard screen, and
click Next.

Material Flush/Fill Wizard fgl

Wizard Completed

.
.

| | JDonel

Figure 6-26: Final wizard screen

Note: After preparing the printer for an extended shutdown period with this
wizard, run the Shutdown Wizard to complete the shutdown process.
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Maintaining the Printer

Routine
Maintenance
Schedule

6-22

The performance of routine maintenance tasks is essential for getting
satisfactory results from Objet 3-D printers. Perform the tasks at specified
intervals for optimum performance.

Frequency Task For More Information
After every print job Clean the print heads See “Cleaning the Print
and the roller surface. Heads” on page 6-23.
Clean the build tray and
the surrounding area.
Weekly Perform the Pattern test. | See “Pattern Test” on
page 6-25.
Weekly Clean and inspect the See “Cleaning and
wiper. Replacing the Wiper”
on page 6-26.
Weekly —when printing | Calibrate the UV See the instructions in
with MED610 intensity. the UV-meter kit.
Weekly Restart the printer
computer and the
server computer.
Monthly, and after Check the alignment of | See “Aligning the Print
replacing print heads the print heads. Heads” on page 6-32.
Every 500 hours of Calibrate the load cells. | See “Calibrating the
printing, or once every Load Cells” on
six months page 6-36.

Every 1000 hours of
printing, or once a year

Preventive maintenance
visit by authorized
service engineer.

Contact your Stratasys
support center.

Once a year

Inspect the activated-
carbon odor filter, and
replace if necessary.

See “Replacing the
Odor Filter” on
page 6-38.
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Cleaning the
Print Heads
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Periodic inspection and cleaning of the orifice plates on the bottom of the
print block ensures that the print nozzles are not clogged. A wizard guides
you through the procedure, and adjusts components of the printer to
enable you to perform it. To maintain your Objet30 printer in optimum
condition, clean the print heads after every print job, when you remove the
model from the build tray. This procedure takes about 20 minutes.

To clean the print heads:
1. Prepare—
* isopropanol (IPA —isopropyl alcohol) or ethanol (ethyl alcohol)

disposable cleaning gloves
* the supplied cleaning cloth or equivalent
* amirror

2. Start the Heads Cleaning Wizard from the Options menu of the printer
interface (see figure 6-34 on page 27).

3. Follow the instructions on the wizard screens, and select the check
boxes to confirm that:

* you have checked that the tray is empty.

* you have closed the cover.

X

Clean Heads Wizard

Clean Heads Wizard

Flease check ifthe tray is empty and close the
doar.

[~ Trayis empty

I~ Dooriz clozed

? Hep

Figure 6-27: Head cleaning procedure—wizard screen
4. Click Next.

The printer prepares for you to clean the print heads.

5. When the following screen appears, open the cover.

Clean Heads Wizard Pz

Caution: Are heads clean ?

Heads Are Hot
Flease open the door and clean heads and roller.

x Lancel | |

? Hep

Figure 6-28: Head cleaning wizard—steps 5-10
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WARNING: The print head orifice plates (bottom surface) may be hot.
Do not touch them with your bare hands, and proceed with caution.

Place the mirror on the build tray.
Put on the gloves.
Soak the cleaning cloth with the cleaning fluid.

o ® N

Clean the orifice plates, with a back-and-forth motion (see figure 6-29).
Use the mirror to make sure that you have removed all of the residue
material.

Figure 6-29: Cleaning the heads

Use this opportunity to clean the entire roller surface, by rotating the roller,
and clean the UV lamp.

10. When you have finished cleaning, select the confirmation check box in
the wizard screen (see figure 6-28) and click Next.

11. Remove the cleaning materials from the printer and close the cover.

12. Select the confirmation check boxes in the wizard screen and click
Next.

The head-purge cycle begins. When this is complete, the final wizard
screen appears.

Clean Heads Wizard El

Heads clean wizard completed

| = | " Done |

Figure 6-30: Head-cleaning wizard—final screen

13. Click Done to close the wizard.
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Pattern Test
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The pattern test is the basic verification of the printer’s ability to produce
quality models, since it demonstrates the condition of the nozzles in the
print heads. Make sure, therefore, that you perform this test weekly, and
whenever you suspect a printing problem.

To perform the pattern test:

1.
2.

Make sure that the build tray is empty.

Prepare a sheet of pink paper, approximately 21 x 14 centimeters in
size (8.5 x 5.5 inches) —half of the standard A-4 or Letter size.

In the printer, tape the pink paper to the center of the build tray.

Press F3, or open the Options menu and select Pattern Test.

<P Perform Pattern Test?

Figure 6-31: Pattern Test confirmation

If the build tray is not clear, click No in the following dialog box.

This lowers the build tray, so that models on the tray are not damaged.

Is the build tray dear?
\_‘/ (If you dick 'NO', the tray will be lowered.)

Figure 6-32: Build tray (Z) level adjustment

The printer prints a series of lines on the test paper (see next figure).

Lines printed by Lines printed by
support-material - g model-material
print head print head

Figure 6-33: Sample Pattern Test

Carefully inspect the test paper to see if there are missing lines.
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Improving
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Too many missing lines, especially if they are in the same area,
indicates that the quality of printing when producing models will be
poor. If this is the case, see “Improving Print Quality,” below.

Note: Acceptable model quality is subjective, and depends on the type
and scale (size) of the models produced. As a rule, however, if two
consecutive lines are missing, or if there are more than 10 lines missing in
either column, the model quality is usually unacceptable.

If you suspect that print quality is poor, perform the pattern test (see
“Pattern Test”). If the results are poor, use the following procedure to
improve print quality.

If the results of the last pattern test are poor:

1. From the Options menu, select Execute Purge Sequence, or press F4.
2. In the confirmation dialog box, click Yes.

The print heads are purged of model and support material, and the
wiper removes excess material from them.

3. Repeat the purge sequence.
4. Perform the pattern test.

If the results of the pattern test are still poor:

1. Manually clean the print heads (see “Cleaning the Print Heads” on
page 6-23).

2. Perform the purge sequence.

3. Perform the pattern test.

If the results of the pattern test are still poor:

1. Carefully clean the print heads again, making sure there is no residue
left on them.

2. Perform the purge sequence.
3. Perform the pattern test.

If the results of the pattern test are still poor:
» Consult with your Stratasys service provider about replacing faulty
print heads.

A rubber wiper removes excess material from the print heads after the
purge sequence. This is done automatically before each print job, and
performed manually during maintenance tasks. You should clean the
wiper and surrounding area at least once a week. If the wiper is damaged
or worn, replace it.

To inspect and clean the wiper:
1. Prepare—
* isopropanol (IPA —isopropyl alcohol) or ethanol (ethyl alcohol)
* disposable cleaning gloves
* the supplied cleaning cloth or equivalent
* aspare wiper
* an M2.5 Allen key
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2. Start the Wiper Cleaning Wizard from the Options menu.

i File Options Help
Al i
-:;; _-’Stratasys Go to Tray Upper Positon F5
! Goto Service Position Fé 20 Dec 2012 11:36
Wipe F7

Pattern Test

| - Wizards Head Alignment

| Maintenance Counters. .. E;aLdS CI?n'Tg ¢
amp Replacement
| Collect Service Data ki I

) Wiper Cleaning - |
|

| L Shutdown Wizard Head Replacement ! |
| Load Cell Calibration I|
| Relnitiate

Material Flush/Fill Wizard

."II @BJET 1 Verownte  Fulcureros "".

{ T Z80gr
f FullCure705

620 gr
VeroWhite

T 640ar
s

Figure 6-34: Starting the Wiper Cleaning Wizard

3. Close the printer cover, and click Next in the wizard screen.
Make sure that the build tray is empty, and close the printer cover.
Confirm this in the wizard screen.

Clean Wiper Wizard E|

Clean Wiper Wizard

Check if the tray is empty and close the door.

[~ Tray iz empty

[~ Dooris closed

XK Cancel | <2 | s |

Figure 6-35: Wiper Cleaning procedure—step 4
5. Click Next.
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6. When the following screen appears, open the cover.

Clean Wiper, Wizard le

Is Wiper clean ?

- Flease open door and clean Wiper.

[~ wiper clean

XK Cancel | =Z | |

Figure 6-36: Wiper Cleaning Wizard during steps 7-10

Put on the cleaning gloves.

Using a generous amount of cleaning fluid and the cleaning cloth,
remove any material remaining on the wiper and the surrounding
area.

9. Inspect the wiper.

If the wiper is scratched, torn or worn, or if you cannot clean it
completely, replace it.

a. With the M3 Allen key, loosen (but do not remove) the screw
securing the wiper.

Figure 6-37: Wiper and excess-material drain
b. Grasp the wiper unit and remove it.

c. Insert the new wiper, making sure that it is level, and tighten the
securing screw.

10. In the wizard screen (see figure 6-36), confirm that the wiper blade is
clean, and click Next.

11. Make sure that you have removed all tools and cleaning materials
from the printer, and close the cover.
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12. Confirm that the tray is clear and that the cover is close, and click Next.

Clean Wiper Wizard le

Clean Wiper Wizard

Check if the tray is empty and close the door.

[~ Trayis empty

[~ Dooris closed

XK Cancel | <% | = |

Figure 6-38: Wiper Cleaning procedure—final confirmation screen

13. Click Done to close the wizard.
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Normally, you do not have to inspect and clean the roller waste collector.
This is done by a customer-support engineer during regular maintenance
visits. Occasionally, however, a blockage or damaged scraper may cause
material leakage on the build tray. If this happens, remove the roller waste

collector to inspect it.

To remove the roller waste collector:

1. From the Options menu, select Wizards > Heads Cleaning.

This wizard prepares the printer for removing the roller waste

collector.

2. When the following screen appears, confirm that the tray is empty and
that the printer cover is closed, then click Next.

Clean Heads Wizard

? Hep

Figure 6-39: Wizard confirmation screen

Clean Heads Wizard

Flease check if the tray is empty and close the
doar.

[~ Tray iz empty

[~ Dooris closed

3

The print block moves to the center of build tray, and the tray lowers.

3.  When the following screen appears, open the cover.

Clean Heads Wizard

Caution:
Heads Are Hot

? Hep

Are heads clean ?

Flease open the door and clean heads and roller.

x Lancel | |

3

Figure 6-40: Wizard screen that appears when you can begin the procedure

WARNING: The print head orifice plates (bottom surface) may be hot.
Do not touch them with your bare hands, and proceed with caution.
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4. Loosen the two side screws securing the UV lamp assembly, and
remove the assembly.

Securing
screws

Figure 6-41: UV-lamp-assembly securing screws

5. Move the print block all the way to the front of the printer, exposing
the roller-waste-collector locking pin.

Figure 6-42: Roller-waste-collector locking pin

6. Pull the bottom of the locking pin, and turn it counter-clockwise, to
raise the drain-tube bracket from the roller waste collector.

Drain-tube
bracket

Roller waste
collector

Roller-waste-collector screws
Figure 6-43: Raising the drain-tube bracket

7. Support the roller waste collector with your hand under it, and use a
3 mm Allen key to loosen the screws.
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8.

Pull out the roller waste collector, taking care not to touch or damage
the scraper.

Waste channel
gscraper

Figure 6-44: Roller waste collector

Inspect the roller waste collector.

* If the scraper is damaged, replace the entire roller-waste-collector
unit.

Save the used unit. At the next maintenance visit, the customer-
support engineer will replace the scraper, for future use.

* If the scraper is not damaged, carefully remove any waste from the
waste channel, taking care not to touch the scraper.

To install the roller waste collector:

Carefully insert the roller-waste-collector unit.
Secure the unit evenly, by alternately tightening the screws.

Turn the locking pin clockwise, to lower the drain-tube bracket onto
the roller waste collector, and secure the pin in its socket (see

figure 6-42 on page 31).

Move the print block back to the middle of the printer.

Replace the UV lamp assembly and secure it.

In the wizard screen, click Cancel to return the build tray to its former
position.

You should check the alignment of the print heads—

once a month

if model quality is not acceptable even after cleaning the orifice plate on
the bottom of the print block (see “Cleaning the Print Heads” on
page 6-23)

The head-alignment procedure takes about 20 minutes.

To check the alignment of the print heads:

1.

Prepare—

* atransparency sheet, at least 10.5 x 13 centimeters in size (4.5 x 5.5
inches)—about one-quarter of the standard A-4 or Letter size

* any type of sticky tape, to fasten the transparency sheet to the build
tray

Start the Head Alignment Wizard from the Options menu (see
figure 6-34 on page 27).

Click Next to begin, and close the cover.
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In the wizard screen, select the check box to confirm that the cover is
closed, and click Next.

Head Alipnment Wizard |X|

Close the Door

? Help | x LCancel | <§ Erevious | Mext } |

Figure 6-45: Door is closed confirmation screen

When instructed to do so, place the transparency on the build tray —
near the left and rear edges of the tray, as shown in the following
figure.

Figure 6-46: Positioning the transparency on the build tray

Make sure that the transparency sheet is lying flat, and tape it to the
tray.

In the wizard screen, select the check box to confirm that the
transparency sheet is on the build tray, and click Next.

The printer prints the head alignment test on the transparency.

When the following screen appears, remove the transparency.

Head Alignment Wizard |Z|

Remove transparency from tray

[~ Transparency removed

%Ereviousl Mest 3 |

Figure 6-47: Head Alignment Wizard—steps 8-10
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10.

11.

The transparency sheet is printed with sets of vertical lines in two rows,
each showing the results from a different print head.

1 2 34 5 6 7 8 91 1 12 13 14 15
RRRNRARRRRRRRRE
| |5

Figure 6-48: Sample head-alignment test
* The top row was printed by the head used for applying model
material when producing models.

Model head

Support head

* The bottom row was printed by the head used for applying support
material.

Use a magnifying glass or loupe to inspect the transparency.

Optimum head alignment is shown when the two #8 lines, in the upper
and lower rows, are aligned, as in figure 6-48. In the example shown, no
change to the head alignment is necessary. If other lines in the set are

aligned, you need to change the alignment—in the next wizard screen.

In the wizard screen shown in figure 6-47, select the Transparency
removed check box, and click Next.

The first in a series of alignment screens appears.

@ |

Head Alignment Wizard g|

Bl o Support Head

II Aligned  choose the best printed line in the transparency

B o

. _
RN
T
e
T
T m
I
O]
]
5
5
5
5
5
5

T e
-
? Help XK Cancel | (Erevious| Lt

Figure 6-49: Head alignment screen

In the head-alignment screen, select the number that indicates which
lines align in the upper and lower rows.

Note: Because the alignment of the middle lines is optimum, the number
“8" is selected, by default, in the wizard screen. This does not change the
head alignment. If you select other numbers, the wizard adjusts the head
alignment, accordingly.
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12. Click Next.

The following screen is displayed.

Head Alignment Wizard rz|
m— Updating System Parameters
Do you want to update the system parameters for
the last calibration results?
‘\-—.__-/

+ ‘ez

? Help x Lancel |

Figure 6-50: Update confirmation screen

13. Continue as follows:

* To make the alignment changes in the printer, make sure that Yes is
selected, and click Next.

* To recheck the alignment test results before making the alignment
changes in the printer, click Previous.

* If you do not want to make alignment changes in the printer at this
time, select No and click Next.

14. In the final wizard screen, choose to either repeat the head alignment
procedure or close the wizard.

* If the most closely aligned vertical lines for a print head were at
either extreme, choose Yes to run the Head Alignment Wizard
again, then click Next.

The transparency test will show if the heads are now properly
aligned, and —if not—the wizard will allow you to “fine tune” the
alignment.

* If the vertical lines for the print heads were not aligned at either
extreme, choose No to close the wizard, then click Next.

Head Alignment Wizard @

L Do you want to repeat the test?

% *es - Print another transparency

" Mo - | want to end of Wizard

-
_ -

? Help x Lancel | ( Previous | Mext ) |

Figure 6-51: Final Head Alignment Wizard screen
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Calibrating the Load cells are sensors that measure the weight of the printing cartridges

Load Cells and the waste container in the printer. It is important that you periodically
check that the weight measurements are accurate, both for convenience and
to prevent unnecessary waste of printing materials. It is recommended that
you calibrate the load cells once a month, with the Load Cell Calibration
Wizard.

To calibrate load cells:

1. Start the Load Cell Calibration Wizard from the Options menu (see
figure 6-34 on page 27).

2. Select one or more load cells that you want to calibrate, and click Next.
Load Cell Calibration Wizard r5_<|

Choose Calibration Mode

[~ Calibrate Madel weight
[~ Calibrate Suppart weight
[~ Calibrate ' aste weight

il

? Hep

Figure 6-52: Load cell selection

Note: Itis recommended that you routinely calibrate all of the load cells,
after 500 hours of printing or once every six months.

3. Remove the cartridge or container, as instructed by the wizard,
confirm this in the wizard screen, and click Next.

Load Cell Calibration Wizard §|

Remove Left Model Cartridge

(.
«
—
L.

? Help x Lancel | ~( Previous | Mext =

Figure 6-53: Confirmation of cartridge removal
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4. Inthe next wizard screen, observe the numbers and wait until the level
is relatively stable —two units above or below the average level shown.

Load Cell Calibration Wizard f'5_<|

Model Weight Status

44D
Current Level 2176

[~ Weight iz stable

qT(

? Hep

Figure 6-54: Load cell calibration screen

5. Select the Weight is stable check box, and click Next.

If you need to calibrate more than one load cell, the next calibration
screen appears. Repeat steps 4 and 5 until all of the load cells are
calibrated.

6. Click Done in the final wizard screen.

Load Cell Calibration Wizard rg|
Wizard Completed
2 1 ([ 5ere |

Figure 6-55: Final wizard screen

cover, and make sure that the drain tube is not bent. Operating the printer
without the waste-container cover results in an inaccurate measurement of
the waste weight, which will cause waste to overflow into the printer.

% If you removed the waste container, make sure to replace it with its metal
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Replacing the  If the printer exhaust is not connected to an external ventilation system, a

Odor Filter built-in activated-carbon filter removes odors from printing materials. This
filter should be replaced regularly (about once a year, as necessary) to keep
your working environment pleasant. This is normally done during the
yearly preventive-maintenance service visit.

To replace the odor filter:

1. Locate the filter drawer at the rear of the printer and pull it open.

Odor filter drawer

Figure 6-56: Rear of the Objet30 printer

2. Remove the used filter. (You can push it out from underneath the
drawer.)

Figure 6-57: Odor filter in drawer

3. Insert a new filter and close the drawer.
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Replacing the  The UV lamp used for curing models has a long, but limited, working life.

UV Lamp The Stratasys service engineer tests its effectiveness during regular
maintenance checks, and replaces it, if necessary. If, for any reason, you
need to replace the UV lamp, follow these instructions:

1. Start the UV Lamp Replacement Wizard from the Options menu (see
figure 6-34 on page 28).

WARNING: Before continuing, make sure that the safety interlock in the
printer cover is not defeated, and that the lamp is not hot.

The online/offline button at the bottom of the printer interface should be
red..

©.05

Figure 6-58: Offline mode indicator (red)

2. Make sure that the build tray is empty, and confirm this in the wizard
screen. Then, close the printer cover and click Next.

U¥Y Lamp Replacement Wizard PZ|

UV Lamp Replacement Wizard

ol
/& 4
N

Clear (empty) the build tray.

@

e

3 ¥

? Help x Lancel | ‘% | ﬂext) |

Figure 6-59: “Empty tray” confirmation screen

The axes move to the “home” position.
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3. Disconnect the UV lamp cable and the fan cable.

UV-lamp connector

UV-fan connector

Figure 6-60: Disconnecting the UV lamp assembly

4. Loosen the two side screws securing the UV lamp assembly to the
printer.

Securing
screws

Figure 6-61: UV-lamp-assembly

5. Remove the assembly, and place it on a flat surface.

6. Loosen the screws securing the UV lamp cover and remove the cover.

Cover screws

Figure 6-62: UV-lamp-cover screws
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7. Loosen the two screws securing the UV reflector.

Reflector
screws

Figure 6-63: UV-reflector screws

8. Remove the UV reflector by raising it slightly, then pulling it out of the
housing at an angle, from the bottom.

Figure 6-64: Removing the UV reflector from the UV assembly
9. Discard the old reflector and lamp.

Dispose of the used UV lamp in accordance with environmental and safety
requirements.

10. Insert the new UV lamp/reflector unit into the housing.
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11. Make sure that the UV-lamp cable is in place, inside the housing, and
then tighten the securing screws.

Figure 6-65: Cable position when installing the UV lamp

12. Replace the lamp cover, and tighten the securing screws.

13. Replace the UV lamp assembly in the printer, making sure that the
cable fits into the slot together with the side securing screw.

Figure 6-66: UV-lamp cable after replacing the assembly

14. Tighten the two side securing screws.

15. In the wizard screen, confirm that you have replaced the lamp and that
the black strip is attached to the reflector; then click Next.

U¥Y Lamp Replacement Wizard le

UV Lamp Replacement Wizard

[~ The UV lamp was replaced.

[ The black strip was comectly placed in the reflectar.

? Hep

Figure 6-67: UV-installation confirmation screen
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The wizard operates the lamp to test if it is installed correctly. If the
lamp does not light, the wizard prompts you to check the power
connections and to re-install the lamp.

U¥Y Lamp Replacement Wizard fgl

UV Lamp Replacement Wizard
Completed

.
— .
9 |

|  Dore |

Figure 6-68: Final wizard screen
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The waste container contains partially cured polymeric material produced
during normal operation and maintenance of the printer. For safety and
environmental reasons, this material is kept in a special leak-proof,
disposable container.

The container has a capacity of 1.8 kilograms of waste material —usually
enough for several weeks of printer use. The printer software displays a
warning message when there is 1.5 kilograms of material in the container,
and stops the printing when the net weight reaches 1.8 kilograms. Above
1.5 kilograms, the software does not allow you to start a print job (or a
printing activity) until you replace the waste container. You can monitor the
weight of the waste container in the Maintenance screen of the printer
interface.

To monitor the waste weight (and other indicators) in the printer:

» In the main printer interface screen, click the display toggle to view the
printer indicators.

File Options_Help _ % |

| :‘" Stratasys

Heads(°C) Sensors
[ 45 |- 12
Maintenance | g0 ort 62 | waste(or) R D Waste weight
| Model G| | Ambient (°C) |
| Heads Liquid |

ﬁ\w Display
toggle button
_VernWh'rle_

T 2mogr
FullCure705

Tray1.objtf

Current Mode: Print Made

=

Figure 6-69: Printer interface, showing waste weight (red background indicates
operator alert)

The waste container consists of a sealed bag inside a cardboard box. You
typically dispose of the entire waste container —including the box.
Therefore, you must assemble a new box and insert a new waste bag before
you can install it in the printer.

Replacement boxes, waste bags, and sealing caps are supplied in the Objet
printer start-up kit and in the preventive-maintenance Kkit.

To prepare a new waste container:

1. Assemble the cardboard box, making sure to punch out the perforated
sections.

2. Fold a new waste bag—so it fits in the box—and insert the bag’s screw-
connector into the hole in the top of the box.

Note: Do not close the box until you connect the waste drain tube from the
printer (see below).
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To replace the waste container:
1. Open the materials drawer.

2. Remove the fireproof cover from the waste container.

Figure 6-70: Removing the waste-container cover
Unscrew the cap securing the waste drain tube.
Carefully lift out the waste container to remove it from the printer.

Close the full container with a sealing cap.

ARSI

Place the new waste container in the materials drawer, and attach the
drain tube to it.

While attaching the cap with the waste drain tube, hold the waste bag
stationary.

7. Close the new waste-container box.

Figure 6-71: Waste container with drain tube attached
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8. Place the fireproof cover over the waste container, making sure that the
drain tube is free and not bent.

Figure 6-72: Fireproof cover installed over the waste container

Note: Operating the printer without the waste-container cover results in an
inaccurate measurement of the waste weight, which will cause waste to
overflow into the printer.

9. Close the materials drawer.

Dispose of the full waste container in accordance with environmental and
safety requirements.

The painted exterior plastic panels of Objet 3D printers have a durable
finish, offering excellent chemical resistance to common cleaning materials.
However, it is recommended that you use only a mild soap solution for
routine cleaning.

Printer modes and configuration settings are stored in files on the printer
computer. You can back up these files, and restore them, if necessary, using
desktop icons.

BackupData Restorelata

Figure 6-80: Backup and restore desktop icons

One of the wizards listed in the Options menu is Relnitiate. You normally do
not have to run this wizard. The process that this wizard controls runs
automatically, when needed, as part of the Pre-print mode (before printing
begins). Run this wizard only if a Stratasys Customer Support engineer
instructs you to do so.
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Handling Printed Models

Removing Models After Printing

N

After printing models, you should allow them to cool as much as possible
before handling them. If additional models do not have to be produced on
the printer, it is best to let the printed models cool in the printer, with the
cover closed, as long as possible.

If the printer must be used to produce additional models as soon as
possible:
1. Let the printed models cool on the build tray for at least 10 minutes.

2. Very carefully, remove the models from the tray with a scraper or
spatula (supplied in the tool kit), taking care not to pry or bend the
model.

WARNING: Wear protective gloves when handling printed models
before they are washed.

3. Place the models on a flat surface, and cover them with a cardboard
box or paper hood.

This allows the models to cool slowly and evenly.

4. Let the models cool for several hours.

Removing the Support Material

7-2

After printed models have cooled, the support material must be removed.
This can be done by different methods, depending on the size of the model,
how delicate it is, the amount and location of the support material, and
other factors. Use the following methods as a guide, and adapt them (or a
combination of them) for finishing the models you are handling.

Removing Excess Support Material by Hand

While wearing protective gloves, break away excess support material on
the outside of the model. For delicate models, use a toothpick, pin or small
brush after dipping the model in water.

Removing Support Material with Water Pressure

For most models, the most efficient way to remove support material is by
using a high-pressure water jet. One suitable system is the Objet Water]et
cleaning unit, shown in figure 7-1 on page 3.
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Figure 7-1: Objet WaterJet Cleaning Unit

To clean a model using this device, you place it in the chamber, and you
manipulate it and the jet using the built-in, waterproof sleeves. A pump
turns ordinary tap water into a high-pressure jet, and a wiper keeps the
window clear.

Use caution when cleaning delicate models with high-pressure water
systems.

Removing Support Material with Caustic Soda

Soak models in a 2-percent solution of caustic soda (sodium hydroxide) to
remove support material from difficult-to-reach areas and to give the
model a smooth, clean finish. The amount of time you soak the model in the
solution depends on how delicate it is and how much support material
needs to be removed, but it is typically between half-an-hour and several
hours. In any case, you should remove as much support material as
possible before the caustic soda treatment, and rinse the model thoroughly
(with a water jet) afterwards.

WARNING: Caustic soda may cause chemical burns, scarring and
blindness. Mixing it with water generates heat that could ignite other
materials.Take adequate safety precautions; always use nitrile gloves
when handling caustic soda and models soaked in it.
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Post-Printing Treatment for Models Printed with Objet VeroClear

Models made with Objet VeroClear have a slight yellow tint when removed
from the printer. This is especially true for models printed with a glossy
finish. The yellow tint fades naturally over time, but you can greatly
accelerate this process by using a suitable photobleaching treatment.

As arule, best clarity is achieved when parts are printed with a matte
finish, and treated as explained below.

Photobleaching models involves exposing them to light. To achieve highly
controlled and predictable results, a professional illumination chamber is
recommended. However, adequate results may be obtained using ordinary
desk lamps fitted with suitable fluorescent elements.

P [

i":*'i‘_ — \ \/

Figure 7-2: lllumination chamber Figure 7-3: Desk lamps
Photo-
Bleaching
Instructions Follow these instructions for photobleaching printed models.

® The fluorescent lamps should be rated 45W, 6500K.

® When using desk lamps, place the models in a container covered with
aluminum foil. Use at least two lamps, more when treating models in a
large container.

® Arrange the models with enough space between them to allow light to
reach all sides of each model.

® Verify that the ambient temperature around the models is
approximately 40°C (104°F). Higher temperatures may cause model
distortion; lower temperatures may not produce satisfactory results.
When using desk lamps, you can achieve the required temperature by
positioning the lamps approximately 10 cm (4 in.) above the models.

® Inspect the models after six hours of treatment.

O For parts with a matte finish, this should be enough. Polish and
lacquer the parts.

O For parts with a glossy finish, continue the photobleaching
treatment for up to 18 hours more.

In Stratasys laboratories, there was a tint reduction of approximately
70% within six hours. After 24 hours, tint was reduced by
approximately 90%.

For more information about this treatment, see the application note
“Objet VeroClear for Desktop Pro Printers” (DOC-24131).
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Storing Models

Models are cured as they are printed, making them safe and stable for a
long time. However, proper storage conditions are necessary to prevent
deforming.

® Keep printed models at room temperature and in a low-humidity
environment.

® Do not expose models to direct sunlight and other heat sources.
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